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このリリースについて  
このドキュメントでは、IMAGINE Photogrammetry（旧 LPS Core）および ERDAS ER Mapperを含む

ERDAS IMAGINE 2020 Update 2（v16.6.2）の機能強化について説明します。本書の情報は製品リリース時

点のものですが、最新のバージョンについては、Hexagon Geospatial Supportのウェブサイトを参照してく

ださい。  

アップデート 2には、機能強化と修正が含まれています。ERDAS IMAGINEで行われた修正については、

「解決済みの問題」セクションを参照してください。  

このドキュメントは概要を説明するものであり、製品の機能のすべての詳細を提供するものではありませ

ん。詳細については、ERDAS IMAGINEに付属のオンラインヘルプやその他のドキュメントを参照してくだ

さい。  

ERDAS IMAGINE 2020の開発では、ERDAS IMAGINEの実質的にすべての側面が 64ビットで動作するよう

にすることに重点を置きました。その結果、インストーラは 3つの独立したインストーラに分割されまし

た。ERDAS IMAGINE 2020 64bit、ERDAS IMAGINE 2020 32bit、ERDAS ER Mapper 2020です。Update 2

のインストーラでも同様の分割が可能です。  

ERDAS IMAGINEの製品層  
ERDAS IMAGINEは、高度なリモートセンシング解析と空間モデリングを行い、新たな情報を生み出しま

す。さらに、ERDAS IMAGINEを使用すると、結果を 2D、3D、またはビデオで可視化し、地図作成品質の

マップコンポジションで表示することができます。ERDAS IMAGINE製品群の中核は、地理空間データ制作

のニーズに合わせて拡張できるように設計されています。特殊な機能を提供するオプションのモジュール

（アドオン）を利用して、生産性と機能を強化することができます。  

IMAGINE Essentialsは、地図作成や簡単なフィーチャ収集ツールのためのエントリーレベルの画像処理製品

です。IMAGINE Essentialsでは、シリアルバッチ処理が可能です。  

IMAGINE Advantageは、高度なスペクトル処理、画像登録、モザイク処理、画像解析、変化検出機能を提供

します。IMAGINEアドバンテージは、出力を高速化するための並列バッチ処理を可能にします。  

IMAGINE Professionalには、高度なスペクトル、ハイパースペクトル、レーダー処理、空間モデリングのた

めのプロダクションツールセットが含まれています。この階層には、ERDAS ER Mapperが標準装備されて

います。  

IMAGINE Photogrammetryは、最先端のフォトグラメトリ衛星画像処理および航空画像処理アルゴリズムに

より、生産性を最大化します。  

  

  

新しいプラットフォーム  
フルインストーラー  

ERDAS IMAGINE 2020 Update 1から、アップデートインストーラーがフルインストーラーになりました。  
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つまり、スタンドアロンでインストールする（ERDAS IMAGINE 2020 Update 2をインストールしてから

ERDAS IMAGINE 2020をインストールする）か、既存のインストールのアップデートとしてインストール

する（ERDAS IMAGINE 2020 Update 2をインストールすると、ERDAS IMAGINE 2020 Update 1がすでに

インストールされていても、既存のインストールが v16.6.2にアップデートされます）ことができます。  

フルインストーラでは、以前のバージョンにアップデートをロールバックすることができなくなりました。

そのため、例えば  

ERDAS IMAGINE 2020が ERDAS IMAGINE 2020 Update 2でアップデートされたため、アンインストール

すると ERDAS IMAGINE 2020が完全に削除されます。そのため、「ロールバック」では、ERDAS IMAGINE

をアンインストールし、目的の旧バージョンを再インストールする必要があります。  

ArcGIS 10.7.x および ArcGIS 10.8.x  

ERDAS IMAGINE 2020 Update 2 (32 ビット) は、ジオデータベース サポート ライブラリを提供するために

インストールされたライセンス バージョンの ArcGIS 10.6、10.6.1、10.7、10.7.1、10.8、または 10.8.1 を

使用する場合にテストされ、サポートされていると宣言されています。  

また、IMAGINE Geodatabase Supportコンポーネント（ArcGIS Engine 10.7ベース）をインストールして、

ジオデータベースのサポートを提供することもできます。  

  

ライセンス  

ERDAS IMAGINE 2020のインストーラでは、インストーラの一部として地理空間ライセンスツールを自動

的にインストールしようとしなくなりました。お客様が地理空間ライセンシングツールを使用する場合（フ

ローティング/コンカレントライセンスサーバーのセットアップなど）、地理空間ライセンシング 2020を別途

ダウンロードする必要があります。  

お客様には、Geospatial Licensing 2020 の最新バージョンにアップグレードすることを強くお勧めします。

疑問がある場合は、Microsoft Windows のプログラムの追加と削除ユーティリティを参照して、現在インス

トールされているバージョンを確認してください。  

適切なダウンロードは、Hexagon Geospatialウェブサイトのダウンロードセクションにあります。  

  

    

 

 

新技術  
IMAGINE DSM Extractorモジュール  

新しい IMAGINE DSM Extractorは、高度な SGM（Semi-Global Matching）アルゴリズムを搭載しており、

ステレオ画像から高速かつ高密度のデジタルサーフェスを生成します。このモジュールは、既存の XPro 

SGMおよび Tridicon SGMモジュールに取って代わるものです。これにより、より高精度な点群を短時間で

生成できるようになりました。IMAGINE DSM Extractorは、IMAGINE Photogrammetryでサポートされてい

るすべてのタイプの画像、センサーデータ、ファイル形式に対応しており、ファイルサイズの制限はありま

せん。  

https://download.hexagongeospatial.com/search?lang=en&product=b3b4786d3d4742ae8d1e7aeee50dae69
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図：UltraCam Eagle Mark 3のカメラから抽出した点群。UltraCam Eagle Mark 3カメラから抽出した点群を

表面として表示したもの。  

新しい IMAGINE DSM Extractorモジュールには、以下のようなメリットがあります。  

• IMAGINE Photogrammetryがサポートするすべてのセンサーをサポート  

• IMAGINE Photogrammetryがサポートするすべての画像フォーマットとビット深度をサポート  

• オンザフライのエピポーラ再サンプリングにより、エピポーラ再サンプリング画像を生成する必要性を排除  

• バッチまたはローカル/分散型並列処理のサポート  

• 強度、RGB、RGBNエンコードされた点群ファイルを生成  
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図.DigitalGlobe WorldView-3画像から抽出した点群を表面として表示したもの。  
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空間モデラーのための新しいオペレータ  

Hexagonは Spatial Modelerにオペレータを追加し続けています。新しい(または変更された)演算子の概要は

以下の通りで、その機能の簡単な説明とともに説明されています。各演算子の詳細については、ERDAS 

IMAGINE 2020ヘルプを参照してください。また、これらの機能の多くを使用する空間モデルの例について

は、Hexagon Geospatial Community Spatial Recipesページを参照してください。  

Associate Georeference 

  

入力地理空間データに関連付けられたジオリファレンス、GeospatialDataIn（現在は IMAGINE.Rasterに限定

されています）を入力ジオリファレンスに置き換えます。この演算子を使用する一般的な使用例について

は、後述の「Spatial Modelerの Raster Geometry」のセクションで説明していますが、以下に列挙する他の

新しい演算子を使用することもできます。  

CRS ID Output  

  

この演算子は、入力された CRS IDで表される座標参照系を、以下のいずれかのファイル形式でファイルに出

力します。  

• ERDAS IMAGINEプロジェクションライブラリ（PLB  

• ジオメディア座標系ファイル(CSF)  

• ERDAS IMAGINE 世界座標系（WCS  

• ESRI予測ファイル(PRJ)  

Classify Vegetation  

 

この演算子は、入力点群から植生を表す点を識別し、低植生（クラス 3）、中植生（クラス 4）、高植生（クラ

ス 5）のいずれかに再割り当てします。  

低・中・高植生クラスを識別するために、オペレータは、点群内の地面に落ちている点がすでに分類されて

いること、つまり地面クラス（クラス 2）に割り当てられていることを想定しています。入力された点群内の

  

https://community.hexagongeospatial.com/t5/Spatial-Recipes/tkb-p/KS_SpatialModeler_AnalyticalRecipes
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地面に落ちている点が分類されていない場合は、Classify Ground演算子を使用して分類することができま

す。  

分類は、最初に非地上点とその近傍点との幾何学的関係を分析することによって行われる。いくつかの幾何

学的記述子（散乱、平面性、直線性、垂直性）が点について計算され、植生点の可能性を決定する際に考慮

される。点群点レコードフォーマットで近赤外および/または赤、緑、青（RGBNまたは RGB）のラジオメト

リック特性がサポートされている場合、これらの特性は、植生点を表す候補を決定するために使用されま

す。  

点群がカラー（RGB/RGBN）属性を持つ場合、各点の植生指数が計算され、ポート VegetationIndexで指定

された値と比較されます。RGBN属性を持つ点群の場合、正規化植生差指数（NDVI）が使用されます。RGB

属性を持つ点群では、緑度指数が使用されます。  

点の植生指数がポート VegetationIndexで指定された値以上の場合、その点は植生として分類される候補とみ

なされます。  

Compute Footprint  

  

この演算子は、ラスタデータのための不要な長方形ではないフットプリントを生成します。出力されるフッ

トプリントは、入力ラスタの有効な（マスクまたは指定された背景値によって決定される非 NoDataの）領域

の範囲/境界を定義する輪郭ポリゴンです。  
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また、以下のような空間モデルを使用して、「フットプリントの外側」を値ベースの NoData（例えば 0）に

設定し、「フットプリントの内側」のピクセルが NoData「穴」として扱われるのを避けるために、その値で

ある「フットプリントの内側」のピクセルを 1 の値に変換することもできます。  

未分化画素で DNが 0のパンデータを入力すると、「穴」（赤い背景色で表示されます）が発生します。 

  

新しい Compute Footprint演算子を使用した空間モデル。  
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NoDataの「サラウンド」がトリミングされ、内部の穴がない結果の出力画像  

  

 

Convert To Point Cloud 

 

この演算子は、特徴量を点群に変換します。  

入力フィーチャの一次ジオメトリフィールドの CRSは、ジオメトリの次元性を決定し、これは 2Dまたは 3D

の CRSである可能性があります。一次ジオメトリフィールドの CRSが 2Dの場合、出力点群の垂直 CRSは

1D不明となります。フィーチャジオメトリが線形または面積である場合、頂点は点群の点を定義するために

使用されます。  

  

        

  



 ERDAS IMAGINE 2020 Update2  

15 

フィーチャのプライマリジオメトリフィールドの CRSが 2Dの場合、入力フィーチャは、データ型が

IMAGINE.Floatまたは IMAGINE.Doubleの ELEVATIONという名前の属性を持っていなければなりません。  

オペレータは、入力された特徴量の属性に基づいてポイントレコードのフォーマットを決定する。  

  

  

Create Affine Conversion 

  

この演算子は、入力アフィン係数とソース CRSに基づいてアフィン変換を作成します。ターゲット CRS（結

果として得られる CoordinateOperationの Toプロパティ）は指定する必要はなく、与えられたアフィン変換

を使用して SourceCRSから派生した GridCRS（派生 CRS）として作成されます。  

Invert入力の意味は、Create Affine Transform演算子とは異なることに注意してください。この Create  

アフィン変換演算子の Invert を true に設定すると、係数によって暗示される数学変換が反転されますが、結

果として得られる CoordinateOperation の To は、その反転された変換によって定義された GridCRS のまま

になります。整流画像の場合、左上のマップ座標とセルサイズを指定する方が自然である（ピクセル間の変

換を意味する）ため、これは Georeferencingを定義する際に便利ですが、Georeferencing 

CoordinateOperationの適切な形式はマップ間のピクセル変換です。  

この演算子を使用する一般的な使用例については、後述の「Raster Geometry in Spatial Modeler」のセクショ

ンで説明します。  

Create Directory  

  

この演算子は、存在しない親ディレクトリも含めて、指定されたディレクトリを作成します。ディレクトリ

がファイルシステム上に既に存在する場合、この演算子は単にディレクトリ名を出力します。指定したディ

レクトリを作成できなかった場合、この演算子は失敗します。  

Define Training Augmentation Parameters  
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この演算子は、既存の訓練データから追加の訓練データを生成するために使用されるパラメータのセットを

作成します。  

選択したオプションに応じて、既存のトレーニングデータのスケーリング、回転、反転、トリミング、ラジ

オメトリックに調整されたバージョンを動的に生成するためのパラメータを指定することができます。既存

のトレーニングを補強することで、物体検出の精度を向上させることができます。  

パラメータは、初期化プロセス中に追加のトレーニングデータを生成するための初期化オブジェクト検出演

算子の入力として使用することができます。  

Delete File  

  

ファイルを削除します。例えば、c:temp\\foo.txtが入力として与えられた場合、そのファイルはファイルシス

テムから削除されます。ファイルがファイルシステム上に存在しない場合、演算子は単にファイル名を出力

します。指定したファイルを削除できなかった場合は、演算子は失敗します。  

Dictionary Input  

  

HDRファイルなどのテキストファイル（Key/Valueペアを含む DiMAP XMLヘッダなど）を読み込んで、空

間モデル内で使用するための辞書に変換します。  

Redefine Grid  

  

グリッドを再定義すると、ラスタのグリッドジオメトリがマップ軸へのアライメント、ピクセルサイズのス

ケーリング、グリッド境界の最小値の 0,0への移動に対応できるようになります。 入力境界は GridBoundary

（つまり、Boundaryの CRSプロパティが GridCRSを表す値を持っている）であることが期待されていま
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す。この再定義では、新たに定義されたグリッドの適切な地理参照を維持しつつ、一般的に懸念されるプロ

パティ、すなわち、方位/回転、スケーリング、並進の変更に対応しています。  

向きに関しては、デフォルトでは、新しいグリッドの軸が TargetCRS（指定されていない場合は、元のグリ

ッドが参照されている CRS）の軸と平行になるようにグリッドが再定義されます。これには、（較正されたグ

リッドの場合は）逆地対画像変換によるグリッドの方向付けや、整流されたグリッドに存在する可能性のあ

る回転要素の除去が含まれる場合があります。  

グリッドのスケールは、X と Y のセルサイズで指定することができます。これらが指定されていない場合

は、BoundaryInが Gridの入力として、TargetCRSが TargetCRSの入力として指定されているときのデフォ

ルトの動作で計算されたセルサイズが使用されます。  

最後に、デフォルトでは、新しいグリッドの境界の最小座標が 0,0 になるように調整されます。このオプショ

ンが適用されない場合でも、入力グリッドの境界全体が出力グリッドで表現できるように、出力グリッドの

境界の制限が設定されます。これには負のグリッド座標が必要になるかもしれません。  

通常、AlignToReferencedAxes のデフォルト値は true で指定され、BoundaryOut は Warp 演算子を使用して

ラスタ入力を再定義されたグリッド ジオメトリにワープします。しかし、値を false にすると、グリッドの

再定義が可能になり、（おそらく新しい）TargetCRSへの再投影として効果的に使用でき、BoundaryOut がワ

ープの代わりに Update Georeferencing に供給されたときにキャリブレーションとして保存されます。  

この演算子を使用する一般的な使用例については、後述の「Raster Geometry in Spatial Modeler」のセクショ

ンで説明します。  

Remove Overlapping Detections  

  

Detect Objects Using Deep Learning演算子を使用してオブジェクトを検出している間、演算子は、同じオブ

ジェクトに対して複数のバウンディングボックスを見つけることがあります。  

この演算子は、2つ以上のバウンディングボックスが  

DetectionOverlapAllowanceの場合は、最も確率の高いバウンディングボックスを保持し、他のすべてのバウ

ンディングボックスを削除します。  

オーバーラップを除去するために使用される非最大化抑制アルゴリズムの一部として、2つのバウンディング

ボックス間のオーバーラップは、それらの交差オーバーユニオン（IoU）を計算することによって決定されま

す。IoUは、2つのバウンディングボックスの結合領域に対する交差領域の比率として定義されます。  

    

オペレーターを更新しました  

Cat  

コンカチネート(Cat)演算子が拡張可能になり、入力文字列のリストも受け付けるようになり、1つの演算子

で 2つ以上の入力を評価できるようになりました。  
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つまり、次のような空間モデルを置き換えることができます...  

  

  

...もっとシンプルなもので、このように見えます。  

  

  

Clump  
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Clump演算子（テーマラスタデータを、元のクラス/DN値が同じで連続するピクセルのグループに再編成す

る）は、いくつかの問題に対処するために書き直されました。主に、新しいマルチスレッドタイルベースの

アプローチによるパフォーマンスの向上と、デフォルトで符号なしの 32ビットデータを出力することを目的

としています。  

注意: この新しい Clump 演算子の動作は、以前の Clump 演算子とは異なり、NoData ではないすべてのピク

セルが塊になるため、0 であっても塊が形成されます。したがって、既存の空間モデルで古い（非推奨）演算

子を新しい演算子で置き換える場合は、結果が異なる可能性があることに注意してください。新しい Clump 

の前に NoData に Set を追加して、同じセットのピクセルを確実にクランプする必要があるかもしれませ

ん。  

Convert To Features  

  

フィーチャへの変換演算子が更新され、（点）フィーチャジオメトリへの変換のための入力として点群を受け

入れるようになりました。以前は、主にラスターを変換することを目的としていました。  

IMAGINE.PointCloudは、点データレコードフォーマット（LAS仕様 1.4参照）で定義されたスキーマに基づ

いて、3D点形状と属性を持つフィーチャに変換されます。IMAGINE.Doubleタイプの追加属性 ELEVATION

は、3Dポイントジオメトリの Z値のコピーを保持します。  

また、この新しい Convert To Features 演算子を使用して、メインリボンの Vector タブに新しい Spatial 

Modeler ベースの Raster to Shapefile ユーティリティを実装しました。  

属性情報は、さらなる解析のためにフィーチャに変換することもできます（フィーチャは必ずしもジオメト

リ属性フィールドを含む必要はありません）。例えば、以下のモデルでは、浮動小数点ラスタ画像のヒストグ

ラム（ピクセル自体ではありません）が、値の解析のために Convert To Features演算子に渡されます。特徴

に変換演算子は，入力データに存在するビン関数（浮動小数点ラスタ値に使用されるようなもの）も保存し

ようとします．モデルは，ビン化されたヒストグラムデータで表される DN値の主要セットを識別し（ヒス

トグラムを昇順にソートし，最も高いヒストグラム値のインデックス位置を識別することで），そのビンの最

小値と最大値を返します（この場合，入力画像は，0.361339から 0.361369のビンに該当する最も多くのピ

クセル値を持っていました）．  
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Create Column(s)  

  

Create Columns(s)演算子が更新され、入力としてリストを受け入れるようになりました。  

Enhance Contrast Using CLAHE  

  

この演算子の結果をプレビューすると、プレビューウィンドウに表示されている範囲とスケールだけが正し

く処理されるようになり、視覚的なフィードバックが格段に速くなりました。  
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Get ECW Options  

  

ColorSpaceという新しいポートが追加されました。これまで、3バンドの ECW画像を作成する際には、3バ

ンドが RGB(truecolor)色空間を表現していることが前提であり、その前提で圧縮最適化が行われていたこと

が指摘されていました。しかし、3つのバンドは、例えば SARデータから得られた 3つのバンドであり、そ

の 3つのバンドが作り出す色は「トゥルーカラー」を表しているわけではありません。  

その結果、この動作を制御するために ColorSpaceポートが追加されました。4つのオプションが用意されて

います。オート、グレースケール、RGB、マルチバンドの 4つのオプションが用意されています。ECW コン

プレッサは、ソース色空間の記述を使用して、圧縮に最適な色空間を決定します。現在、RGBオプションの

み代替色空間（YCbCr）を使用し、3バンド RGB画像の圧縮効率を向上させています。RGB以外の 3バンド

画像に RGBオプションを使用すると、RGBから YCbCrへの変換式に組み込まれた仮定により、望ましくな

い圧縮結果が得られる可能性があることに注意してください。  

Auto が選択されている場合、Raster が 1 つのバンドを持つ場合、ColorSpace はグレースケールに設定さ

れ、そうでない場合は Multiband が使用されます。  

出力 ECWファイルの NoDataマスクの色を制御し、黒または白に設定できるようになりました。この機能

は、プリファレンスを介して一般的な ERDAS IMAGINEで利用できます。  

Get Geometric Model Info  

 

GridBoundary は、Spatial Modeler でラスタージオメトリを表現するための決定的な方法として推進されてい

ます。そのため、Get Geometric Model Info演算子で調べる Georeferencing演算は、GridBoundaryまたは

GridCRSとして提示できるようになりました。  

Initialize CART Regressor and Initialize Random Forest Regressor  
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これらの演算子は、どちらも従属属性変数のリストを手動で入力する必要があり、時間がかかりエラーが発生

しやすいものでした。これらは、提供された TrainingDataから利用可能なもののリストから適切な属性フィー

ルドを選択することを可能にするグラフィカル・ユーザ・インタフェースを提供するために更新されました。  

 

Initialize Object Detection  

  

以前の物体検出では、航空機ではなく自動車などの小さな特徴を識別しようとすると、問題が発生することが

ありました。その結果、以下の検出例に示すように、より小さな特徴をよりよく処理できるようにオペレータ

が強化されました。  
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 Logical And and Logical Or 

これら 2つの演算子は拡張可能になり、入力のリストも受け入れられるようになり、1つの演算子で 2つ以上

の入力を評価できるようになりました。  
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Point Cloud Information  

  

点群情報演算子がブール演算子で更新され、通過する点群の点数と境界を強制的に計算するようになりまし

た。これにより、上流プロセスによって操作された可能性のある点群に対して、これらの値の精度が保証さ

れます。  

Raster Output  

  

ラスター出力に新しい統計情報入力ポートが追加されました。これは、出力にカスタム統計情報を設定する

必要があるために追加されました。AOI、スキップファクター、無視値などを使用して作成された統計情報を

渡すことができます。  

新しいフォーマット入力ポートも追加され、提供されたファイル名の拡張子に基づいて決定されるままにす

るのではなく、作成するフォーマットを定義するようになりました。  
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Read Sensor Metadata  

  

Read Sensor Metadataが更新され、GeoEye-1だけでなく、様々な種類の DigitalGlobe/Maxar WorldViewセ

ンサーからメタデータを読み取るようになりました。  

Simplify Geometry  

  

ShrinkOnly ポートが追加されました。このポートは AreaGeometry フィーチャにのみ適用されます。これが

真の場合、簡略化されたジオメトリは元のジオメトリ内に完全に収まることが保証されます。  

例えば、次の 2つのグラフでは、緑のポリゴンが入力ジオメトリ、赤のポリゴンが簡略化された結果です。

左のグラフは、ShrinkOnlyを真とした場合の結果を示しています。右のグラフは、ShrinkOnlyを falseにした

結果を示しています。  
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Various Math Operators Updated to Accept Lists 

  

また、さまざまな数学演算子が更新され、Lists を入力として受け入れるようになり、Iterator の出力との相互

作用がより簡単になりました。  

空間モデラーのラスタジオメトリ  

序章  

空間モデラーは、処理作業を簡単に組み立て、効率的に実行できるように努力しています。モデル作成者の

労力を軽減しようとする主な試みの一つは、様々なデータ表現に直面しても賢明な操作が成功するように、

データ変換を自動化することです。  

地理空間的な処理タスクの場合、このデータ変換は通常、座標操作、すなわち、同じ座標参照システム

（CRS）で 2つ以上のデータソースの座標を表すことで、同じ場所を表すデータを認識できるようにする必

要があります。  

Features や PointCloud のような明示的なジオメトリを持つ地理空間データの場合、座標操作はほとんどのユ

ーザーにとって馴染みがあり直感的です。暗黙的なジオメトリを持つ地理空間データ、すなわち Rasterに対

する操作は、より厄介な傾向があります。Spatial Modelerの Rasterジオメトリの簡略化された表現である

Grid Boundaryは、国際的な定義と標準を完全に支持しつつ、これらの操作をより簡単に理解し、実行できる

ようにしようとしています。  

ジオメトリ変換とジオリファレンス補正の比較  

地理空間データの種類（Features、PointCloud、Raster）にかかわらず、ジオメトリ変換とデータセットのジ

オリファレンス情報の修正の区別を理解することが重要です。  

幾何学変換では、地理空間データの地理参照情報が正しいと仮定し、この情報を使用して、明示的または暗

黙的な座標値を別の座標参照系に再参照することを容易にします。これは、座標変換、標高変換、点群再投

影、ワープなどの演算子を使用して実現できます。  

一方、地理参照補正では、地理空間データの地理参照情報が不完全であったり、誤りがあったりすることを

想定している。その意図は、明示的または暗黙的な座標値を修正することではなく、それらの値の解釈方法

を修正することである（ラスタのグリッド座標の場合、外部座標参照系との関連付け方を変更することも含

まれる）。このような変更を行うには、Associate Georeference や Attach Vertical CRS などの演算子を使用す

ることがあります。ラスタ補正の中には、Redefine Grid、Create Affine Conversion、Associate Elevation な
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どの演算子を使用して、Associate Georeference への入力を準備しなければならないような難しいケースも

あります。  

代表的な使用例  

以下の典型的なユースケースでは、グリッド境界と関連する表現を使用してラスタージオメトリを操作する

方法を説明しています。  

CRS Association  

Raster 入力にはワールドファイルが関連付けられていますが、CRS が識別されていません。空間モデルの他

のデータとの信頼性の高い統合のために、どのようにして CRSの定義を Rasterに関連付けることができま

すか？  

この結果を得るためには、以下のようなモデルを用いることができる。  

  

のような直接入力を経由して、または座標参照システム ID入力演算子の Inputプロパティを所望の CRSに設

定することで、CRSの値を変更することができます。  

  

または UI プロバイダ（CRS セレクタ）と対話することで、CRS 定義が Associate Georeference 演算子で関

連付けられているときに、Raster Input でインポートされた関連付けられたワールドファイルからの地理参照

操作が保持され、その出力は所望の地理参照を持つようになります。元の入力は、図に示すように、Update 

Georeferencing 演算子を使用して永続的に更新することができる。データ形式が IMG や TIF のように地理参

照を保持できるものであれば、その地理参照はデータセット内に全体として配置され、ワールドファイルは

不要になります。  

Georeferencing 

既知の CRSにおける左上隅座標と、参照されていない画像のセルサイズは既知である。空間モデルの他のデ

ータとの信頼性の高い統合のために、この情報をどのようにラスターに関連付けることができるでしょう

か？  
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このケースは、CRS アソシエーションのケースに似ていますが、Create Affine Conversion 演算子を使用し

て、Raster と既知の CRS を既知の georeferencing パラメータで直接関連付ける必要があります。以下のモ

デルは、このアプローチを示しています。  

  

Create Affine Conversionの Invertパラメータが trueに設定されていることに注意してください。これは、ア

フィン係数を計算するためにピクセルからマップへのパラメータを提供していることを示しており、アソシ

エート Georeferenceに正しいマップからピクセルへの操作を提供するためには、このパラメータを反転させ

る必要があります。  

前のケースと同様に、入力データセットは Update Georeferencing演算子で直接更新してもよい。実際、

Associate Georeferencingを使ってモデル内でオンザフライで入力を更新する必要がない場合、Create Affine 

Conversionの出力は直接 Update Georeferencingに送られるかもしれません。  

Linear Transformation  

ラスターデータは、その地理参照の現在の形式に混乱しているあまり能力のない GISツールによって消費可

能なものにするために、反射を必要とします。地理参照を保存するグリッド空間変換はどのように行われる

のでしょうか？  

以下のモデルは、元の画像の地理参照を保持しながら、画像ピクセルの垂直反転を行います。元の地理参照

を保持したいので、入力ピクセルを別のデータセットに保存する前に、新しく定義されたラスタージオメト

リにワープする必要があります。  
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垂直方向に反転させるには、画像を変換して拡大縮小する必要があることに注意してください。正しい変換

は高さ -1 で、y 軸を -1 のスケールで反転する前に、最下段の左端のピクセルの中心が原点になるようにしま

す。  

  

ラスタジオメトリは、以下に示すように、Linearly Transformly Georeferenced Image サブモデルを使用して

操作します。  

  

元の GridCRSから垂直方向のフリップ係数を用いてアフィン変換を行うと、新しい GridCRSへの演算が生成

されます。この新しい GridCRSは、その操作から取得し、入力グリッドの再定義に使用することができま

す。  

グリッド境界をWarpに与えることは、必要な出力グリッド境界を直接定義する唯一の方法です。Create 

Affine Conversionの出力を直接Warpに提供しても、望む結果は得られません。  

Reprojection  

地理参照されたラスタデータを明示的に別の外部座標参照系に再参照するには？  

この操作で厄介なのは、通常、出力セルサイズを決定することです。Redefine Grid は、以下のモデルのよう

に XCellSize などのポートに何も入力がない場合、デフォルトの Calculate Cell Size を使用します。この動作

は、モデル内で明示的に Calculate Cell Size を使用し、その出力を Redefine Grid に供給することで、より細

かく制御することができます。  
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ワープやラスター出力の代わりにアソシエイト・ジオリファレンスとアップデート・ジオリファレンスを使

用すると、元のデータセットのジオリファレンス情報に再投影キャリブレーションを配置することができま

す。  

Rectification  

参照可能な画像は、画像に関連付けられたセンサモデル情報にアクセスできない、能力の低い GISツールに

よって消費されてしまう可能性があるため、再び整流が必要となります。空間モデルではどのようなアプロ

ーチがあるのでしょうか？  

以下のモデルでは、Redefine Grid を使用して、参照可能なグリッドを参照先の外部座標参照系に方向付けし

ています（これは、TargetCRS が与えられていない場合のオペレータのデフォルトの動作です）。高品質の地

対地変換を確実に行うために、DEM入力を与えることができます。示されているように、Redefine Grid は内

部的に Calculate Cell Size のデフォルト値を使用しますが、モデル内で明示的に Calculate Cell Size を使用す

ることで、より細かい制御が可能になります。  
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任意のグリッド幾何学におけるタイルの要求  

空間モデルは、ジオプロセシングイメージサーバーのタイル配信をサポートし、サポートされている任意の

CRSのタイルを配信することができます。このようなモデルのジオメトリ操作の側面にアプローチするため

の推奨される方法は何ですか？  

このユースケースにアプローチする一つの方法は、指定されたターゲット CRS IDに基づいて、指定されたラ

スター入力に対して要求されたタイルを配信するために準備されたモデルを作成することである。ターゲッ

ト CRS IDを提供しない場合は、ラスター入力のピクセル座標でタイルを要求したいことを示します。タイル

要求サーバは、ラスター入力、ターゲット CRS IDに基づいてモデル実行をキャッシングし、要求を適切なモ

デルに指示することができる。Warp演算子は、適切に定式化されていれば、任意のスケールの要求を扱うこ

とができます。これは、Target CRS IDのエクステントと関連するタイルサイズを使用して容易に構築するこ

とができます。  

  

このセクションで言及されている用語の用語集（例：「CRS」）については、空間モデラーのヘルプを参照し

てください。  

  

空間モデルエディタのインターフェースの改善  

ある空間モデルから別の空間モデルへの演算子のコピーと貼り付けが、ソースモデルとターゲットモデルの

相対的なズームスケールに依存しないようになりました。  

また、サブモデル（イテレータを含む）からの終了（Collapse Submodel）時には、サブモデルに入った時に

使用されていたズームエクステントが再構成されるので、不意に空間モデルの別の部分にジャンプしてしま

うことがありません。  

Spatial Modelerの新しい写真測量ワークフロー  

過去数年の間に、画像取得システムで取得されるデータ量は飛躍的に増加しており、特に低コストの UAVプ

ラットフォームの出現と普及が原因である。この効果は、画像の空間分解能だけでなく、取得頻度にも現れて

おり、毎日の再訪率が一般的になっています。これに伴い、非常に短いターンアラウンドタイムでデータを自

動的に処理する必要が出てきました。  

フォトグラメトリ・ワークフロー（調整、オルソ補正、カラーバランシング、モザイク処理）は、通常、デー

タ処理の最初のステップです。大量の画像を処理するためには、新規取得を自動的に検出し、利用可能になっ

たらすぐにデータを処理し、必要に応じてコンピューティング・リソースを拡張し、下流の地理空間プロセス

に出力を供給するように構成できるフォトグラメトリ・ソリューションが必要です。  
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Spatial Modelerは、このような課題を解決するために設計されています。何百もの演算子を持ち、複雑な地

理空間問題を解決するモデルに簡単に連鎖させることができます。  

このリリースでは、プロジェクトのセットアップ、自動点測定、三角測量、およびスキャン・フレームおよび

デジタル・フレーム・カメラ用のモザイク処理を実行する写真測量演算子の新しいスイートを追加して、

Spatial Modeler の機能を拡張しました。これらの新しいオペレータの多くは、空間モデルの実行の一部とし

て実行するために追加のライセンスが必要です。これは通常、各オペレータのヘルプに記載されています。  

Add Images to Block  

 

実行するには IMAGINE Advantage以上のライセンスが必要です。  

このオペレータは、空間モデル内で処理中のブロックに画像を追加します。画像は，ブロックが作成された

ものと同じセンサモデルタイプでなければなりません．この処理の一環として、画像の内部方位が解かれ

る。また、パラメータ辞書で指定された値に応じて、画像の外向きの状態が設定される。  

パラメータで指定したパスに画像が見つからない場合は、オフラインとして設定され、正しいパスが設定さ

れるまで下流の処理には含まれません。  

    

Add Terrains to Block 

 

実行するには IMAGINE Advantage以上のライセンスが必要です。  

オペレータは、1つまたは複数のデジタル地形モデルをブロックに追加します。追加された地形データは、ブ

ロックが入力として使用されるオルソ整流やモザイク加工などの操作で使用することができます。  

Block Information  

 

扱うように定義されているセンサカテゴリや CRSなど、ブロックの基本情報を提供します。  
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Block Input  

  

ブロックファイル（IMAGINE Photogrammetryで作成したブロックファイルやブロック出力演算子など）

を、空間モデル内で利用できる形式に読み込みます。  

Block Output  

  

指定したブロックの内容をファイルとして保存します。出力されるファイル名は FilenameIn で指定した名前

になりますが、 これが空の場合は一時的な名前が生成されます。いずれの場合も、出力されるファイル名は 

FilenameOut となります。これは IMAGINE Photogrammetryブロックファイルになり、IMAGINE 

Photogrammetryで開いたり、見たり、操作したりすることができます。  

    

Create Block  

  

実行するには IMAGINE Advantage以上のライセンスが必要です。  

ブロックと呼ばれるフォトグラメトリプロジェクトを作成します．ブロックのセンサーモデルのタイプは、

BlockParametersで決定されます。  

Spatial Modelerは、複数のセンサモデル用のブロックファイルの作成をサポートしています。Camera、

RPC、および Rigorousセンサモデルです。各センサタイプについて、「Define Sensor Parameters for 

<Sensor type>」演算子は、センサのブロックファイルを定義するために必要なパラメータを収集します。こ

の演算子で収集された情報は、BlockParametersポートを介して Create Block演算子に渡されます。例え

ば、カメラモデルのブロックファイルを作成するには、「Define Block Parameters For Camera Model」演算

子を使用して、ブロックファイルの設定に必要なパラメータの情報を収集します。  
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Create SGM Point Cloud Output  

  

実行するには、IMAGINE DSM Extractorまたは同等のライセンスが必要です。  

この演算子は、SGM（Semi-Global Matching）を用いて、一対のステレオ画像から密な点群を抽出します。  

左：ステレオペアから点群を生成するための空間モデル。右：生成された点群を表面モデルとして表示  
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Define Adjustment Options for Camera Model  

  

この演算子は、カメラモデルブロックで実行されたときに、バンドル調整の実行演算子プロセスの結果に影

響を与えるために使用できるオプションを組み立てます。これらのオプションの詳細な説明は、空中三角測

量のヘルプを参照してください。  

  

Define Block Parameters For Camera Model 

  

カメラ画像のブロックを設定するために必要なパラメータを定義します。  
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Define Camera Parameters For Digital Camera 

 

特定のデジタルカメラのパラメータを定義します。例えば、以下のようなものです。  

  

    

Define Camera Parameters For Frame Camera 

 

  

  



 ERDAS IMAGINE 2020 Update2  

37 

特定のフレームカメラのパラメータを定義します。  

Define Image Parameters For Camera Model 

  

これは、カメラセンサーモデルを画像に追加する際に使用する画像パラメータのセットを作成します。  

  

Define Mosaic Input Options  

  

この演算子は、モザイク画像演算子で使用する入力オプションを定義します。例えば、使用する入力画像の

フットプリントを決定するためのアクティブエリア法や、モザイク処理の一部としてオルソレクティフィケ

ーションが適用される可能性がある場合に使用する標高ソースなどです。  
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Define Mosaic Output Options  

  

セルサイズや座標参照系、適用するリサンプリング手法など、Mosaic Images 演算子で使用する出力オプシ

ョンを定義します。  

Define Mosaic Radiometry Options  

  

Mosaic Images オペレータで入力画像に色補正を適用する際に使用するオプションを定義します。  

Define Mosaic Seamline Options 

  

シームラインの位置からの距離など、モザイク画像演算子で使用するシームラインの生成と処理オプション

を定義します。  

Define Point Match Options 

  

この演算子は、画像ごとに生成するポイント数など、Generate Tie Points 演算子で使用するポイントマッチ

オプションを定義します。  
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Generate Tie Points  

  

実行するには IMAGINE Photogrammetryのライセンスが必要です。  

入力ブ ロ ッ ク に よ っ て与え ら れた画像の リ ス ト に対し て、 同点を自動的に見つけます。  

Mosaic Images  

  

実行するには IMAGINE Advantage以上のライセンスが必要です。  

入力画像にモザイク処理を適用します （一般にブ ロ ッ ク に よ っ て定義 さ れます）。  

    

Oriented Raster Input  

  

この演算子は、 解いた写真測量プロジェクト（ブロック）から方向付けされた画像を作成します。こ の画像

は、 ブ ロ ッ ク プ ロ ジ ェ ク ト 内に存在す る 必要があ り 、 プ ロ ジ ェ ク ト 内に存在す る 3D モデル情

報に基づいて方向付け さ れます。  

Run Bundle Adjustment  

  

実行するには IMAGINE Photogrammetryのライセンスが必要です。  

この演算子は、ブロック内の制御点、タイポイント、チェックポイントを使用して、入力ブロック内の画像

に対して三角測量を実行します。反復が収束し、二乗平均誤差（RMSE）が指定されたしきい値以下になれば

三角測量は成功とみなされます。三角化が成功しなかった場合は、警告メッセージがログに記録され、

BlockOut は空になります。  
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三角測量のパラメータは、AdjustmentOptions入力ポートに辞書として指定することができます。  

AdjustmentOptions辞書は、「Define Adjustment Options For <sensor category> Model」演算子のいずれかに

よって生成することができる。例えば、「Define Adjustment Options For Camera Model」演算子を使用し

て、カメラモデルのパラメータ値を指定する辞書を作成することができます。  

Update Data Paths In Block  

  

実行するには IMAGINE Advantage以上のライセンスが必要です。  

ブロックにはファイルシステムに存在するデータセットへの参照が含まれています。この参照は完全なパス

の形をしており、パスが無効になる可能性のあるアクションがあります。例えば、データが移動されたり、

プロジェクト全体が移動されたりした場合、これらのパスを更新する必要があります。この演算子は、検索

対象の指定されたディレクトリに基づいて、ブロック内のデータ（画像、地形、オルトス）のパスを更新し

ます。  

IncludeSubFoldersが trueに設定されている場合は、指定されたディレクトリとそのサブフォルダの中から、

ブロック内のデータのルート名と一致するデータを探し、見つかった場合はブロック内のパスが新しいデー

タパスに更新されます。  

更新できるパスがない場合はエラーです。すべてではありませんが、更新できるパスがある場合は警告が表

示されます。  

    

Read Image Parameters For Camera Model  

  

この演算子は、ファイル名ポートで参照されているテキストファイルから、カメラモデルの画像パラメータ

を読み込みます。各画像のパラメータセットは、Define Image Parameters For Camera Model 演算子で作成

されたものと同じ形式の辞書として出力され、Add Images To Block 演算子の入力として使用することができ

ます。  

プロジェクト情報をテキストファイルにエクスポートする手段を提供する写真測量ソフトウェアパッケージ

のカメラプロジェクトのプロジェクト情報は、このようにしてインポートすることができる。  

HPF Resolution Merge  
顧客からのフィードバックに基づいて、パンシャープデータの HPF Resolution Merge テクニックが Spatial 

Modeler を使用するように近代化されました。これは、ダイアログ上で表示とプレビューのオプションを持つ
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ようになったことを意味します。また、データの暗い部分に 0 の値を持つピクセルが導入されるなどの以前

の問題（一部の地理空間アプリケーションでは「穴」として認識されていました）を回避することもできま

す。  

 

    

フォーマットサポート  

DiMAP v2 RPCオートアソシエーション  

DiMAP v2フォーマット（SPOT 6、SPOT 7、プレアデスなど）では、RPC情報（存在し、適切な場合）を

画像に自動的に関連付けるようになり、データのデフォルトの空間精度が向上しました。  

また、GCP を測定したり、Raster タブ > Geometry グループ > Geometric Calibration メニュー > 

Orthorectify without GCP ユーティリティを使用する前に RPC 情報を手動で関連付けたりする必要がな

く、このような画像をバッチで簡単にオルソ修正することができるようになりました。  

今回のリリースでは、DiMAP V2画像の読み込みも大幅に高速化されています。  

JFIF (JPEG) および TIFF での EXIF および XMP タグのサポート  

低価格カメラプラットフォームの普及に伴い、EXIF（Exchangeable Image File）や XMP（Adobe's 

Extensible Metadata Platform）などのタグを使用して、TIFFや JPEG File Interchange Format（JFIF）など

の画像ファイル内に保存される追加メタデータの使用が増えています。  

一般的な例としては、ハンドヘルパーカメラで撮影した写真の Lat / Lonや、ドローン画像の飛行方位情報な

どがあります。  

これらのオプションのタグは、ERDAS IMAGINEで読み取ることができるようになり、Spatial Modelerで処

理パラメータを定義するために使用されます。  
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以下に、撮像時のカメラ位置・方位情報の抽出方法を示す空間モデルを示す。  
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OSDDEF BIIF サポートを更新しました 

EXIFタグ及び XMPタグの使用と同様に、OSDDEF BIIFプロファイルデータにおけるテキストセグメントの

サポートが強化され、追加の画像パラメータをデコードして公開するようになりました（例えば、Spatial 

Modelerの Metadata Input演算子を使用して飛翔高度情報を読み取ることにより）。  

Pleiades Neo  

2021年初頭には、エアバス社は 4機の同一新世代の衛星を打ち上げ、既存の光学衛星とレーダー衛星のコン

ステレーションに加わり、性能を向上させる予定です。  

エアバス社は、発売前のプロトタイプ画像サンプルとドキュメントを提供しており、これらの DiMAP v2デー

タのサポートは ERDAS IMAGINE 2020 Update 2に追加されています。サンプルの追加提供に伴い、さらな

る最適化が行われる予定です。  

ICEYE  

ICEYEの小型衛星 SAR画像コンスタレーションは、高い再訪率と高解像度画像の頻繁な配信のためにカスタ

マイズされています。  

提供されたサンプル GRDデータは現在サポートされています。今後、追加サンプルが配信された際には、さ

らなる最適化が行われる予定です。  

Capella  

カペラスペースは最近、彼らの Xバンド SAR衛星の最初のコンステレーション、セコイア衛星を打ち上げま

した。  

提供されたプロトタイプの GEOデータは現在サポートされています。追加サンプルが配信された際には、さ

らなる最適化が行われる予定です。  

MIE4NITFの TREデコードサポート  

以下の追加 TREが NITFコンテナからデコードされるようになりました。  

MTIMSA - この TRE は、TRE が検出されたイメージセグメント内のモーションイメージデータの公称フレー

ムレート、フレーム番号、タイムスタンプを指定します。この情報は、画像セグメントに関連付けられた現

象層、カメラセット、カメラ、時間間隔、時間ブロックに関連付けられています。  

MIMCSA - この TREには、モーションイメージのフレームレート範囲、使用されたエンコーディング方法、

時間的サブサンプリングが行われたかどうかに関する高レベルのメタデータが含まれています。  

TMINTA - この TRE は、1 つ以上の時間間隔の開始時刻と終了時刻を定義します。複数の TMINTA TRE を使

用して、データが収集されているときに時間間隔を"オンザフライ"で定義することができます。ファイル内の 

MI データの時間間隔定義を含む TMINTA は、そのファイルに存在します。与えられたファイルは、1 つ以上

の"時間的に隣接する"時間間隔に対応する他のファイルからの TMINTA TRE を持つこともできる。  

MTIMFA - この TREは、指定されたカメラセットと時間間隔の現象層のすべてのカメラのモーション画像デ

ータをどのように時間ブロックに分割するかを指定します。また、時間ブロックを画像セグメントインデッ

クスに関連付けます。  

https://www.iceye.com/sar-data
https://www.iceye.com/sar-data
https://www.capellaspace.com/technology/
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CAMSDA - この TREは、カメラセットを定義し、CCS上にカメラを配置し、コレクション内のすべてのカメ

ラに現象学的レイヤ IDと UUIDを割り当てます。  

CSEXRB - Common Sensor Exploitation Reference Data.  

NITF 27ビット J2K  

NITF 2.1 の 32 ビットワードに格納された 27 ビット J2K 画像は、以前は一貫して表示されませんでした。こ

のタイプのデータを適切にデコードするために、基礎となる JPEG 2000デコードライブラリが更新されまし

た。  

SNIP NITF  

SNIP NITF データのサポートが最新の仕様に合わせて更新され、追加の DES および TRE (CSATTB, ILLUMA, 

ILLUMB, CCINFA, MATESA, PIXMTA, CSEPHB, CSCSDB, CSSFAB) のデコードが可能になりました。  

NITFの DEDセグメント  

一部の NITFファイルコンテナに埋め込まれている可能性のあるデジタル標高データ(DED)セグメントがサブ

イメージとして読めるようになりました。  

NITFの BadPixelSegment  

BadPixelSegment データは、イメージ チェーンを使用して開いたときに、テーマ表示モードにデフォルト設

定され、適切な色が適用され、プロパティ ペインに凡例が表示されるようになりました。  

12ビット YCbrCr TIFF  

一部の 12ビット TIFF画像（YCbrCr JPEG圧縮を使用したもの）は、以前は ERDAS IMAGINEによって 8

ビットデータとして解釈されていました。これが改善され、データが正しくデコードされ、12ビットとして

扱われるようになりました。  

このため、古いバージョンの ERDAS IMAGINE で開いた既存の YCbrCr JPEG TIFF 画像では、統計情報、ヒ

ストグラム情報、ピラミッドが .Aux ファイルと .rrd ファイルに誤って保存されている可能性があります（結

果として、洗い流されたような表示になってしまう）。これらの補助ファイルを削除し、ERDAS IMAGINE 

2020 Update 2を使用して再生成すると、正しく表示されるようになります。  

Sentinel-1  

このリリースでは、Sentinel-1 SARイメージの読み込みが大幅に高速化されるはずです。  

Sentinel-3  

Sentinel-3 SAFEデータ（ラスタデータが NetCDFファイルに格納されている）が、ジオコーディング情報を

含めて直接読み込めるようになりました。  

ＤＴＥＤ  

このリリースでは、DTED ラスタデータの読み込みが大幅に高速化されます。  

PlanetScope レベル 3  
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PlanetScope レベル 3A および 3B データは、その XML ヘッダーファイルを介して直接読み取ることができ

るようになりました。  

HDF5  

マルチセグメントの ASTER全球放射率データ（GED）V003などの HDF5ファイル用の新しいラスタ形式の

直接読み込みがあります。  

Esri *.asc  

.prj ファイルと一緒に配信された Esri *.asc ファイルが正しく読み込まれるようになりました。  

ソセットグリッド  

データ型が混在する SocetSet GRIDファイル  

プリズマ  

PRISMAレベル 1、2の HDF EOS 5フォーマットのデータを直接読み込めるようになりました。  
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一般的な ERDAS IMAGINE  

2Dビューの関連データ  

データは必ずしも「1つのファイル、1つのデータセット」パターンに従う必要はありません。

GeoPackage、NITF、HDFなどのフォーマットはすべて、1つのファイル内に複数の関連するデータセット

を保存することができます。このようなファイルを ERDAS IMAGINEの 2Dビュー、3Dビュー、またはマッ

プビューにドラッグ＆ドロップすると、構成データセットの 1つにアクセスして表示するデフォルトの動作

が行われます。ファイルセレクタを使用してファイルを選択した場合、サブイメージ（または同様のタブ）

が表示され、構成データセットを探索して選択して使用することができます。しかし、どちらの場合も、最

初に選択した時点では、表示されたファイルから追加のデータが利用可能であることは、ソフトウェアのユ

ーザには明らかではないかもしれません。  

そこで、コンテンツパネルの関連データセクションの出番です。表示されている親ファイル内の各構成ラス

タデータセットに対して、元の親ファイルと一緒にサブイメージプロキシファイル (.sbi) が自動的に作成され

ます。元の親ファイルがフィーチャを含む GeoPackage である場合、構成されるフィーチャデータセットご

とに GeoPackage Features プロキシファイル (.gfp) が自動的に作成されます; .gfp ファイルは、元の親ファ

イルと一緒にサブディレクトリ (<元のファイル名>.proxy) に作成されます。元の親ファイルがシェイプファ

イルを含む NITFの場合、シェイプファイルは元の親ファイルと一緒に自動的に抽出されます。プロキシファ

イルと抽出されたシェイプファイルは、他の ERDAS IMAGINEツールで構成データを処理するために使用す

ることができます。  
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機械学習レイアウトの改善  

Machine Learning Layout のリボンタブ（ファイルタブ > Layout > Machine Learning Layout）は、生産性を向

上させるために再編成されました。レイアウトには 2つのメインタブがあります。  

Collect Tab - このタブは、マシンインテレクトの初期化に使用するトレーニングイメージチップやフットプリ

ントを抽出するためのものです。  

プロセスタブ -このタブは、主にディープラーニングベースの分類や物体検出のプロジェクトの設定、処理、

管理を行います。機械知能の初期化/トレーニング、分類/オブジェクト検出、処理後の結果のレビューはこの

タブで行います。  

リボンタブの再編成に加え、レイアウトに以下の機能が追加されました。  

• オブジェクト検出ワークフロー - オブジェクト検出ネットワークの初期化・トレーニング、オブジェ

クト検出ワークフローの実行 - これまで Spatial Modelerでのみ利用可能だった「オブジェクト検出ワ

ークフロー」が、Layoutでも利用可能になりました。  

• 初期化されたマシン・インテレクトのインポート - 機械学習レイアウト・フレームワークの外で初期

化されたマシン・インテレクトをレイアウトにインポートして、分類やオブジェクト検出を実行する

ために使用することができます。これは、[プロセス] タブ > [初期化グループ] > [結果のレビュー] ド

ロップダウン・メニューの [マシン・インテレクトの読み込み] オプションを使用して行います。  

 

リボンに埋め込まれた Inquire Cursorにライブアップデートオプションが追加されました。これを有効にする

と、カーソルが 2Dビュー上でドラッグされると、Inquire Cursorは CellArrayに表示されている値を継続的に

更新します。  

射影座標系  

予測座標系の対応を以下のように変更しました。  

  

問い合わせカーソル"ライブアップデ

" 

O 按配   
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EPSG コードが欠落しているマレーシアの 3 つの RSO 予測が追加されました。  

オーストラリアの GDA 2020ゾーンは、選択しやすいように、プロジェクション・チューザーのオーストラ

リアカテゴリーで公開されています。  

CARIB97の鉛直データを追加しました。  

2013年カナダ測地学的鉛直データム(CGVD2013)に対応しました。  

SIPSルールに基づくイメージチェーンの自動回転  

画像が Image Chain メソッドを使用して最初に表示されるとき、センサーのタイプが 2D ビューで File、

North、Up のいずれで表示されるかを決定するために SIPS コントロールファイルが参照されます。  

例えば、DigitalGlobe WorldView-2 NITF データは、デフォルトで Up is Up に回転している場合があります。  

この動作は、File is Up が好ましい場合には、新しい環境設定で上書きすることができます（環境設定エディ

タ > Viewing > Image Chain > Follow SIPS Rotation Behavior > On/Off）。  

イメージチェーンのためのヒストグラム操作  

手動ダイナミックレンジ調整(DRA)が視覚的に簡単になりました。イメージチェーンを使って画像を表示する

際に、ストレッチパネルに入力ヒストグラムと出力ヒストグラム、およびデフォルトの DRAパラメータで定

義されたブレークポイントを表示することができるようになりました。ユーザーは、ブレークポイントの最

小値と最大値を簡単にスライドさせて、更新されたルックアップテーブル（LUT）値による現在のヒストグラ

ムへの影響を確認できます。  
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イメージチェーンで有効なプロファイルツール  

3つのプロファイルツール(スペクトル、サーフェス、プロファイル)はすべてイメージチェーンとして表示さ

れたデータで動作するようになりました、例えば、レリーフイメージチェーンを使って表示された DEM上で

定義されたこの相互参照性のある空間プロファイルのように。  

 

Additional Tabs Enabled with Image Chains 

イメージチェーンを介して表示されるデータがアクティブな場合、[描画]タブと[書式]タブが表示されるよう

になりました。これらのタブのほとんどのツールは通常通りに動作します。  

    

イメージチェーンを使った領域の成長  

イメージチェーンの「描画」タブからアクセスできるようになったツールの一例として、特徴抽出を支援す

る Growユーティリティがあります。  
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連結ローテーションメニュー  
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画像を特定の値に回転させるためのオプション（上を上にする、センサーのルック方向など）は、リボンイン

ターフェースの異なる場所で繰り返され、時には重複していますが、異なる用語を使用しています。これは、

一貫した用語が使用されるように合理化されており、オプションへのアクセスが容易になるようにオプション

が複製されています。  

Sentinel-1 E-Z Coherence Change  

Sentinel-1 E-Z Coherence Change ユーティリティが更新され、Sentinel-1 Aおよび B衛星データの使用が可

能になりました（すなわち、単一の軌道パスに制限されなくなりました）。  

Sentinel-1 Orbit Correction 

この機能により、解析者は ESAのウェブサイトからダウンロードしたパラメータで Sentinel-1画像の軌道エ

フェメリスデータを更新することができます。これにより、画像のメタデータが恒久的に変更され、新しい

メタデータがその後のすべての処理に使用されます。  

 

    

Sentinel-1 Beta-0 Conversions  

ラジオメトリック変換 (Beta-0) ユーティリティが Sentinel-1 画像をサポートするようになりました。このユ

ーティリティは、受信ステーションが配布した DN値から各ピクセルをセンサーが受信した絶対ラジオメト

リックに変換します。これは、受信ステーションから各シーンに提供されるメタデータを使用して行われま

す。  
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マグニチュード位相変換のための IとQの往復  

この機能により、解析者はピクセル値をインフェーズと直交波からマグニチュードとフェーズに変換するこ

とができます。レーダーのピクセル値は、一般的に受信時にインフェーズと直交成分として保存されます。

一般的に、これらのピクセル値は、視覚的な解釈にはマグニチュード、干渉測定にはフェーズというよう

に、マグニチュードとフェーズに変換されるのが一般的です。  

通常、データファイルを読み込んで 2Dビューアなどで画像を表示する際に使用する ERDAS IMAGINEのラ

スターリード DLLは、I&Qディスクストレージを自動的にマグニチュードとフェーズに変換してくれます。

したがって、ほとんどのお客様はこれらの変換を使用する必要はありません。  

UAVや政府機関の資産に搭載されているような一部のレーダーセンサーには、ERDAS IMAGINEが提供する

ラスター読取り DLLが搭載されていません。これらのセンサでは、ERDAS IMAGINEで解析する前に I & Q

フォーマットを変換する必要がある場合があります。あるいは、マグニチュード＆フェーズ画像をより基本

的な I & Qフォーマットに変換することが望ましい場合もあります。これも一般的ではありません。  

    

リニア-デシベル変換  

レーダー画像のピクセル値は、線形分布と対数分布のいずれかで分析することができます。対数分布は伝統

的にデシベルと呼ばれています。このユーティリティは、どちらか一方から他方への変換を提供します。  

サポート  

ソフトウェアで発生する可能性のある問題のトラブルシューティングを支援するために、セッションログで

は、インストールされたバージョンの ERDAS IMAGINEに関連する完全なビルド番号と、その上に構築され
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た空間モデラーSDK（SMSDK）の指定が一覧表示されるようになりました。この情報は、作成可能な

System Reportファイルにも表示されます。例えば、セッションログは以下のようになります。  

Session Log  
-------------------  
User: jdoe  
Date: Wed Oct 21 15:34:29 2020  
Host: myserver  
OS Version: Windows NT 6.2 Build 9200  
GPU: Available  
Locale: en-US  
Software: ERDAS IMAGINE 2020  
Version: 16.6.0.1920  
Spatial Modeler SDK Version: 16.6.0.2006 
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システム要件  
ERDAS IMAGINE 
コンピュータ/プロセッ

サ  

64 ビット Intel 64 (EM64T)、AMD 64、または同等の n(4つ以上の論理プロセッサを強く推奨)  

メモリ(RAM)  16GB以上を強く推奨  

ディスク容量  

• ソフトウェア用 6GB  

• データの例としては 7GB  

• データストレージの要件はマッピングプロジェクトによって異なります 1  

オペレーティングシステ

ム２、３．  
4  

• Windows 10 Pro (64ビット)  

• Windows 10 Enterprise (64ビット)  

• Windows Server 2016 (64ビット)  

• Windows Server 2019（64ビット  

ソフトウェア  

• OpenGL 2.1以上（これは通常、サポートされているグラフィックカードに付属しています 5)  

• Javaランタイム 1.7.0.80以上 - IMAGINE Objectiveは JREを必要とし、バージョン 1.7.0.80以上の

JREをインストールして設定したものを利用することができます。  

• Python 3.6.x または 3.7.x (Python は Spatial Modeler でオプションで使用可能)。   

• Microsoft DirectX® 9c以上  

• .NET Framework 4.7.2以上  

• OpenCL 1.2で倍精度(cl_khr_fp64)をサポートするデバイスを使用して NNDiffuseや他の演算子を

GPUで高速化したい場合  

• ディープラーニングとの併用には、CUDA機能を搭載した NVIDIAカードをお勧めします。  

推奨の 

グラフィックスカード  
ステレオディスプレイ 6  

• NVIDIA® Quadro® P6000、P5000、P4000、P2000  

• NVIDIA® Quadro® M6000、M5000、M4000、M2000  

• NVIDIA® Quadro® K5200、K5000、K4200、K4000、K2200、K600、K420  

推奨のステレオ  
ディスプレイモニター  

• NVIDIA 3D Vision™キットを搭載した 120 Hz (またはそれ以上)の LCDモニター、または  

• Schneider Digitalの 3D PluraViewシステム 7  

周辺機器  

すべてのソフトウェアのインストールが必要です。  

• スクロールホイールまたは同等の入力デバイスを備えたWindows互換マウス 1台   

• 印刷にはWindows対応のハードコピー機器が必要です。  

ソフトウェアセキュリティ（Hexagon Geospatial Licensing 2020）には、以下のいずれかが必要です。  

• イーサネットカード、または   

• ハードウェアキー用の USBポートが 1つ  

高度なデータ収集には、次のいずれかのハンドコントローラが必要です。9  

• TopoMouse™または TopoMouse USB™を使用します。  

• イマージョン 3Dマウス  

• マウストラック   

• ステルス 3D（液浸）、S3D-Eタイプ、シリアルポート  

• ステルス Z、S2-Zモデル、USB版  

• ステルス V、S3-V型（シリアルデバイスとして追加  

• 3Dconnexion SpaceMouse Pro 10  

• 3Dconnexion SpaceExplorerマウス 10  

• EK2000ハンドホイール  

• EMSEN ハンドホイール  

https://www.3d-pluraview.com/en/
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 ・ Z/I マウス  

ArcGIS と GeoMedia  
相互運用性  

 

 

 

 

ERDAS IMAGINEは、GeoMedia 2018または GeoMedia 2020がインストールされたコンピュータ

に安全にインストールすることができます。ただし、互換性を高めるためには、互換性のあるバー

ジョン(アップデートを含む)をインストールすることを強くお勧めします。  

ERDAS IMAGINE 2020はライブリンクに GeoMedia 2020が必要です。設置順は関係ありません。  

ERDAS IMAGINEは、個人用のジオデータベース(*.mdbと*.gdb)の両方のタイプと相互作用するこ

とができます。  

ERDAS IMAGINE は、ArcGIS® バージョン 10.6 ～ 10.8.1 を搭載したコンピュータに安全にインス

トールできます。  

  ERDAS IMAGINE および IMAGINE Photogrammetry (32 ビット) は、ArcGIS Server 10.6 ～ 

10.8.1 ジオデータベース サーバ (ArcSDE) と対話できます。o  適切なバージョンの 

ArcGIS for Desktop バージョン 10.6 ～ 10.8.1 をインストールしてライセンスを取得する。   

o  IMAGINE Geodatabase Supportのインストール (ArcEngine 10.7ベース) - ライセン

スは必要ありません。  

データベースエンジン  

 

 

PostgreSQL 9.6 with PostGIS 2.3: PostGIS を使用して GeoMedia Features (.pfp) を格納することが

できます。  

Oracle Server 12c 12.2 64 ビット。Oracle Server 12c を使用して、Oracle GeoRaster (.ogr) 

(Oracle Spatial が必要)、SDE Raster (.sdi) (ArcGIS for Server が必要)、Oracle Spatial Features 

(.ogv) (Oracle Spatial が必要)、および GeoMedia Features (.ofp) を保存することができます。  

  Microsoft SQL Server 2017 64ビット。Microsoft SQL Server 2017 を使用して GeoMedia を保存す

ることができます。  
機能(.sfp)  

ERDAS IMAGINE システム要件ノート  
1 ディスク I/Oは通常、地理空間データ処理において最も遅いタスクです。高速なハードディスクは生産性を向上させます。1台のディ

スクからデータを読み込み、2台目のディスクに一時的なデータを書き込み、3台目のディスクにデータを書き込むと、パフォーマン

スが向上します。ディスクアレイは生産性を向上させますが、RAIDオプションの中にはパフォーマンスを低下させるものもありま

す。ネットワークディスクドライブは、ネットワークの制限を受けます。  

2 IMAGINE Photogrammetry、ORIMA、ERDAS ER Mapperでは、サーバーオペレーティングシステムはサポートされていません。  

3 IMAGINE Photogrammetryでは、3D立体視と周辺機器の要件により、オペレーティングシステムのオプションが制限されています。  

4 ERDAS ER MapperはWindows 8ではサポートされていません。Windows 8.1では使用可能とされています。  

5 Windowsは、サポートされているすべてのグラフィックスカード用の汎用 OpenGLドライバを提供しています。しかし、これらのア

プリケーションには、OpenGL最適化されたグラフィックスカードとドライバをお勧めします。  

6 IMAGINE Photogrammetryおよび ORIMAの旧バージョンで認証されたグラフィックカードも互換性がある場合がありますが、現在

のバージョンでは認証されていません。ドライバは R418よりも新しいものでなければならない。NVidiaは 2019年 4月 11日にリリ

ースされた R418 U4(425.31)以降にリリースされたドライバの 3D Visionサポートを終了した。  

7 以前のバージョンの IMAGINE Photogrammetryおよび ORIMAで認証されたステレオモニターにも対応している場合がありますが、

現在のバージョンでは認証されていません。  

8 HP-RTL ドライバの使用を推奨します。Windows 64ビットプリントサーバーには 64ビットプリントドライバーが必要です。  

9 Stealth S-Mouse（S2-Sモデル）と MOUSE-TRAKは、Stereo Analyst for ERDAS IMAGINEで唯一サポートされているハンドコント

ローラです。  

10 3Dconnexionマウスは IMAGINE Photogrammetryでサポートされています。    
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解決済みの問題 - ERDAS IMAGINE 2020 

Update 2  
 

IMAGINE Essentials 
 

Issue ID  Summary – IMAGINE Essentials  Description / How to Reproduce  

00055139  Roaming an image displayed on 
top of OpenStreetMap basemap 
crashes ERDAS IMAGINE 2020  

Reproduced this issue with a specific image:  
1. Load the Gdansk_Lostowice_5cm.tif image to the 2D View  
2. Open Home>Basemap>OpenStreetMap  
3. Zoom in, zoom out, pan and after about 1 minute ERDAS IMAGINE will 
crash  

00038767  ERDAS IMAGINE 2018 Update 2 
gives error while opening a (GDAL 
created) IMG file in the Viewer  

Customer reported that while opening an *.img file in IMAGINE 2018 update2 
Viewer, IMAGINE gives the following error messages:  
Spatial Model failed in Raster Input. The error was "eimg_AllStatsStackRead 
failed  
eimg_AllStatsStackRead failed  
eimg_StatisticsGetSkipFactors failed  
eimg_LayerScalarStatisticsParametersRead failed  
StatisticsParametersRead failed  
FileDataRead failed  
emif_ConvertToHost failed  
emif_MIFtoObject failed  
emif_MIFtoBaseData failed  
No memory"  
IMAGINE opens the file in the viewer, but the error message is not desirable. 
Converting the GDAL IMG to another IMG using ERDAS IMAGINE solves the 
issue. Appears to be caused by GDAL not correctly populating the statistics 
node.  

00009390  APOLLO Essentials ECWP slower 
in ERDAS IMAGINE than in other 
GIS applications  

When opening any ECWP within ERDAS IMAGINE the display speed is 
considerably slower in comparison to other GIS applications.  

00065411  S3 connection fails when region of 
S3 bucket is not ‘us-east-1’  

A user located outside of the U.S. is experiencing a problem when trying to 
connect to their S3 bucket in ERDAS IMAGINE 2020. The error says:  
Unable to parse ExceptionName: AuthorizationHeaderMalformed Message: 
The authorization header is malformed; the region ‘us-east-1’ is wrong; 
expecting ‘eu-central-1’  
They have tried to specify the region with a ‘config’ file in 
C:\Users\USERNAME\.aws, but it did not resolve the problem.  

00070931  Inquire Box error - Datum 
undefined, unable to perform 
geodetic transformation  

When using the Inquire Box with an image that is not projected to Geographic 
Lat/Lon, if you change the Inquire Box’s coordinate Type to Lat/Lon and click 
the Apply button it causes the error “Datum undefined, unable to perform 
geodetic transformation". The error does not occur in ERDAS IMAGINE 2018 
Update 2 (v16.5.2)  

00059178  Missing Auto Variable for World 
Files output in Image Command 
Batch Editor  

A customer would like to generate hundreds of *.j2w world files (e.g. for *.jp2 
files) using the Image Command in batch mode. The default setting in this 
command for the "World File" output variable seems to be "User". This setting 
forces the user to switch to "Auto" and define a pattern which, according to the 
rules for world files, cannot be other than the same path and name as the input, 
but with a different extension.  
The Auto Variable with pre-defined pattern works in other commands in batch 
mode, e.g. in the "Reproject" command after having selected "One or more 
inputs, one output".  
To reproduce:  
1. Run Edit Image Metadata from Manage Data tab  
2. Select one input file from data - lanier.jp2  
3. Activate Map Model to World File option  
4. Click Batch  
5. In the Batch Command Editor you can see that WorldFile column populated 
with correct path and extension.  
6. Use Add Files... to load the rest of the images. World File column for those 
will not be filled.  
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Usually "One or more inputs, one output" option allows to use the pre-defined 
pattern. In this case you always need to manually define pattern for World Files 
along with extension:  
Next to the Variables line click Edit  
Select WorldFile variable. Define the Type to Auto and past following to the 
Pattern line  
$(Input.Path)$(Input.Root).j2w  
Once the pattern defined, click close. The WorldFile column will be populated 
with corresponding filenames.  

00050270  Importer for ENVI HSI .hdr format 
fails with large input data  

Import ENVI HSI .hdr format to IMG fails with larger input data (~30GB+)  
To see problem  
1. Manage Data > Import Data  
2. Format: ENVI/AISA Hyperspectral (Direct Read)  
3. Input File: \\alpha\JIRA_data\IM-50434\SP_PD_P_160202_1941_A.hdr  
4. Output File: (enter user specified location and filename)  
5. After ENVI/AISA Hyperspectral (Direct Read) opens, select OK (using all 
defaults)  
 
Import starts, then recurring errors are thrown. Neither the OK and OK to All 
error dialogue or the Process List Kill are responsive to terminating the task. 
The imgcopy.exe task may have to be killed through Windows Task Manager.  
23/08/19 15:35:17 SessionMgr(5044): ERROR: #8087 from efio_Seek  
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to perform seek on 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img  
23/08/19 15:35:17 SessionMgr(5044): ERROR: #7930 from efio_Win32Seek  
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to seek to byte offset -
2135024896 in 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img  
23/08/19 15:35:17 Unknown error code - 131  
23/08/19 15:35:17 SessionMgr(5044): ERROR: #8087 from efio_Seek  
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to perform seek on 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img  
23/08/19 15:35:17 SessionMgr(5044): ERROR: #7930 from efio_Win32Seek  
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to seek to byte offset -
2127170560 in 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img  
23/08/19 15:35:17 Unknown error code - 131  
The importer is reported to run successfully using smaller input data sizes 
(~400MB). Smaller data was not included with the sample data. Will request 
smaller working sample data.  

00050270  ENVI Importer output image 
projection is defined differently 
from the HDR projection 
parameters  

The projection parameters assigned to the output image from the ENVI 
importer are different than the projection parameters in the ENVI .hdr file.  
The Spheroid/Datum is expected to be assigned is WGS 84, not GRS 
1980/NAD83  

00058100  Stop the crash: ECW data cannot 
be saved after editing via Fill or 
Interpolate functions  

To reproduce:  
1. Open attached TheVillagesSubset2008.ecw image in 2DView  
2. Follow the Edit Value of a Single Pixel workflow 
https://hexagongeospatial.fluidtopics.net/reader/XWswM6TZr3V__hu3iKjbGA/f
7HPLVFqpmWzNyjg2YvpBQ  
3. Right-click on the image in Contents window and click Save Layer As... .  
4. Specify the output file name and pick ECW as file format. Right after creating 
output file, ERDAS IMAGINE will crash. The output file will have no edits 
applied.  
 
If you save the layer to IMG format, it will be processed successfully. But 
saving to ECW format is crashing ERDAS IMAGINE. Same behavior after 
editing using Interpolate tool (Multispectral Tab > Edit Group)  

00067214  Map coordinate and projection 
information isn’t written to output 
JPEG 2000 image file  

Map and Projection information from the input raster isn’t written to the .JP2 
output raster file itself. Spatial information is written to the associated .aux file. 
This can be an issue when the JP2 raster is used outside of the ERDAS 
IMAGINE environment. This is a regression - ERDAS IMAGINE 2015 and 
earlier versions do write the spatial information directly to the JP2 output raster 
image.  
To recreate:  
Run any ERDAS IMAGINE application that writes raster output. Specify JPEG 
2000 from the ‘Files of Type’ menu in the ‘Output File’ dialogue window.  

00067272  Sentinel-1 data that is appended 
to long folder pathnames allowed 
by Windows, will not display in 
ERDAS IMAGINE  

Sentinel 1A data that is appended to a (long) pathname length allowed by 
Windows, will not display in ERDAS IMAGINE. Errors are returned including 
“Could not open TIL file” in an error dialogue box.  
To recreate:  
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Copy the Sentinel 1A scene (and it’s et of child sub-directories) 
“S1A_IW_SLC_1SDV_20200522T083100_20200522T083129_032675_03C8D
7_BCAF” to this pathname (or equivalent pathname length) 
“C:\Warehouses\Dataset\SMA_Imagens\Sentinel1A\S1A_IW_SLC_1SDV_202
00522T083100_20200522T083129_032675_03C8D7_BCAF”  
Attempt to display the data in the 2D View by picking Files of type ‘Sentinel-1 
SLC’ and selecting “s1a-iw1-slc-vh-20190811t070240-20190811t070305-
028518-033965-001.xml” from the scene ‘annotation’ folder.  

00049419  Issue reading JPEG 2000 raster 
format produced by IPP sdk  

JP2 image reads improperly in ERDAS IMAGINE 2018 (as a noisy image), 
while correctly in ERDAS IMAGINE 2016 and other GIS applications. The 
Metadata tool shows that ERDAS IMAGINE 2018 changes pixel values when 
reading this image.  
To produce this image customer has used following: IPP sdk from Intel. Version 
7.0 . build version 205.  

00062796, 
00061155  

"ERROR: Unexpected byte count 
after conversion from ANSI Code 
Page (936)" with Chinese locale  

Customer reports this error when running different programs (Layer Stack, 
Spatial Modeler). The errors seem to occur when the applications attempt to 
open the data.  
The problem was initially reported at the Hexagon Geospatial Community. A 
ticket was submitted, and testing indicates the problem is related to the 
Chinese Windows locale ‘zh-CN’. The customer verified the problems are not 
seen after switching the system to locale 'en-US'.  
ERROR: Unexpected byte count after conversion from ANSI Code Page (936)  

00008451  Printing map composition using 
"Fit to one Panel" option relocates 
North arrow and scale bar 
positions  

Printing a map composition using the "Fit to one Panel" option moves the North 
arrow and scale bar to different map positions. Other map elements (symbols, 
text, map frames) maintain their relative map position. ). This happens when 
printing to PDF, GeoPDF, and printers with a smaller page size than the map 
composition. The map frame is scaled to fit one panel, but the scale bar and 
North arrow are repositioned and resized.  

00061924  Export lossy MrSID from an 
img/ige large input does not write 
a valid raster output  

Export MrSID does not create a valid output if ‘Lossless compression’ is 
unselected. If ‘Lossless compression’ is selected a usable output is generated.  

00038716  TIFF image (with Tie Points) that 
crosses over International Date 
Line does not display correctly  

A TIFF image that crosses over the International Date Line does not display 
correctly.  
If you do not use the Orient Image to Map System raster option when opening 
the file then ERDAS IMAGINE will display the image, but the session log 
reports the error “RMS error for this polynomial approximation is too high: 
89.999861.” If you then try to display the OpenStreetMap basemap in the same 
2D View the image becomes a long, thin horizontal line.  
If you use the Orient Image to Map System raster option when opening the file 
the image is displayed as a long, thin horizontal line and the session log reports 
the same error “RMS error for this polynomial approximation is too high: 
89.999861.”  
The image cannot be displayed in Geospatial Portal or ERDAS APOLLO Data 
Manager.  
The TIFF image supplied by the customer crosses over the International Date 
Line. The reference projection is Geographic Lat/Lon.  

00057431  Coordinate Calculator crashes 
when setting output projection  

The Coordinate Calculator tool crashes with the error “coordcalc.exe exited 
with status -1073741819“ in the 64-bit version of ERDAS IMAGINE 2020 
Update 1 when you set the output projection. The problem does not happen 
when using the 32-bit version of ERDAS IMAGINE 2020 Update 1 or ERDAS 
IMAGINE 2018 (the Coordinate Calculator is still a 32-bit app in the 64-bit 
version of ERDAS IMAGINE 2018).  
Steps to reproduce problem:  
1. Start the Coordinate Calculator tool (Manage Data tab > Conversion group > 
Coordinate Calculator).  
2. Load the provided coordinate file “atl_state_plane.gcc” (File > Load).  
3. Set the output projection (Projection > Set Output Projection and Units)  
4. In the Output Projection and Units Setup dialog click the Set Output 
Projection button.  
5. In the Projection Chooser dialog set the projection to “UTM Clarke 1866 
NAD27 North, Zone 16” and click OK.  
6. Click OK in the Output Projection and Units Setup dialog.  
7. The Coordinate Calculator crashes, and the session log reports 
“coordcalc.exe exited with status -1073741819“.  
 

00063017, 
00062863, 
00059127  

Cannot read Sentinel-1 GRD 
image using the xml header file  

ERDAS IMAGINE crashes when reading Sentinel-1 GRD using XML file.  
To recreate:  
Display the Sentinel-1 GRD image by selecting the xml file saved in the image 
“annotation” sub-folder. Imagery can be successfully opened directly from the 
TIFF files in the “measurement” folder.  
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00061905  Resample calculates invalid 
resample output parameters for 
cell size and number of columns 
and rows with specific data and 
the Rubber Sheet model  

Resample calculates invalid resample output parameters for cell size and 
number of columns and rows with provided data.  
To replicate:  
1. Open provided image in 2D View  
2. Panchromatic tab > Transform & Orthocorrect group > Control Points  
3. Select Rubber Sheeting from Model List  
4. After GCP Tool Reference Setup dialogue opens, select GCP File (.gcc), OK  
5. Select clip1ref.gcc, OK, then Close  
6. File Menu > Load Input GCPs  
7. Select clip1input.gcc, then OK  
8. Select Resample icon  
 
Illogical calculations for Number rows, Number Cols, Output, and Cell size are 
generated.  
Repeat the exact same procedure using ERDAS IMAGINE 2018. Reasonable 
calculations are generated.  

00002875  “Send View to JPG” from Office 
Tool in ERDAS IMAGINE is 
creating bad worldfile  

Customer reported that the “Send View to JPG” from Office Tool in ERDAS 
IMAGINE is creating an incorrect worldfile.  
The customer wanted to use the 2D View content as a geo-registered JPEG 
that will work in other applications. According to the customer the World File 
that is generated has an error in the 2nd or 3rd line.  
The customer added that this appears to be similar to the problem described 
several years ago. Thought it important enough to encourage Intergraph to 
finally solve this problem.  
The issue is with the skew parameters in the world file, which appear to be 
given very, very small values rather than being 0.0.  

00054109  “Raster to Shapefile” feature 
doesn’t create prj file with 
customer data.  

Customer reported that “Raster to Shapefile” feature doesn’t create prj file 
along with the shapefile sets, even if the input raster file does have projection. 
According to the customer the raster thematic file was created by Supervised 
Classification in ERDAS IMAGINE.  

00063822  ERDAS IMAGINE 2020 64-bit 
crashes with tbbmalloc.dll as 
faulting module  

Customer reported an issue that they couldn’t start ERDAS IMAGINE 2020 64-
bit from auto-save. Stated that an initial crash had occurred when just adding 
rasters to the 2D View. After that initial crash when launching ERDAS IMAGINE 
2020, it prompts the user that there is an auto save file detected. When 
choosing YES to load the session file or NO to ignore (it doesn't matter) the 
software closes unexpectedly.  
Event Viewer shows:  
Faulting module path: C:\Program Files\Hexagon\ERDAS IMAGINE 
2020\bin\x64URelease\tbb\tbbmalloc.dll  
The issue was tracked to a problem with the Locale setting for the computer, 
combined with a problem with installed Fonts.  

00071304  Help page for Feature Count Tool 
doesn’t document shapefile output 
option  

Feature Count Tool has options to write output to three formats: annotation, 
shapefile, and text file. Online Help did not include the shapefile output option.  

 

 

 

   

IMAGINE Advantage 
Issue ID  Summary – IMAGINE Advantage  Description / How to Reproduce  
00069646  ERDAS IMAGINE 2020 crashes 

while saving edits to thematic image 
with shapefile on top  

There are two actions that lead to a crash. Both scenarios provided below.  
Scenario 1. Recode tool:  
1. Load 16th_naga_finalclass_83g.img to the 2D View  
2. Load 17thcycle_nagaland_rcnf_83g.shp to the 2D View  
3. Select thematic image and run Thematic tab > Edit group > Recode  
4. In the Recode window make some edits. E.g. I have selected rows from 6 to 
11, defined new value as 6. Click Change Selected Rows and Apply. Leave 
Recode window open  
5. Select thematic image in Contents and run Table tab > View group > Show 
Attributes  
6. Right click on thematic image and pick Remove Layer. Click Yes to save 
edits on both notification messages. ERDAS IMAGINE will crash  
 
Scenario 2. Thematic raster edits:  
1. Load 16th_naga_finalclass_83g.img to the 2D View  
2. Load 17thcycle_nagaland_rcnf_83g.shp to the 2D View  
3. Select thematic image in Contents and run Table tab > View group > Show 
Attribute  
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4. Edit e.g. color of some class  
5. Right click on thematic image and pick Remove Layer. Click Yes to save 
edits. ERDAS IMAGINE will crash  
 

00054277  ERDAS IMAGINE 2020 compute 
statistics issue when using Recode  

Computing statistics using Image Metadata in ERDAS IMAGINE 2020 
produces result different from ERDAS IMAGINE 2018.  
Customer uses Raster>Thematic>Recode tool since it allows to generate 
output file within the GUI. This tool reads the Row number of the thematic 
image as original Value. Customer’s data having mismatch of Row number and 
actual image file's value. That's why in his workflow, he firstly computing 
statistics for the input image to match the image file values with the Row 
number and then run a Recode.  
With the release of ERDAS IMAGINE 2020, computing statistics no longer 
matching those. To reproduce: compute statistics for the attached image using 
Image Metadata>Edit>Compute Pyramid Layers/Statistics... in ERDAS 
IMAGINE 2018 and in ERDAS IMAGINE 2020.  
ERDAS IMAGINE 2018 matches the image file value to the Row number, while 
ERDAS IMAGINE 2020 does not.  
Also, when running this image through a simple model having Raster Input -> 
Raster Output operators in ERDAS IMAGINE 2020, the histogram of the output 
raster changes so that Row number matches the image file value. Which works 
in the same way as ERDAS IMAGINE 2018 computes statistics.  

00058219  Raster Thematic Recode does not 
write correct IMG output using 
specific TIFF input data  

Raster Thematic Recode does not write correct IMG output using specific TIFF 
input data  
Problem can be recreated with customer data, but problem is not seen with 
every input file. Recode generates expected IMG output when using other TIFF 
and IMG input files. The sample input TIFF image is reportedly generated from 
other IMAGINE processes.  
To recreate:  
1. Run Raster Thematic Recode  
2. Input File: \\alpha\JIRA_data\IM-52611\wv2_4007_recode_3class_stk_v2.tif  
3. Select Setup Recode…  
4. Select Row Value = 2, Enter New Value = 1, then Change Selected Rows  
5. Select OK to dismiss Thematic Recode dialogue  
6. Select Output File icon  
7. Be sure Files of Type is set to ’IMG’  
8. Enter output filename  
9. Then OK  
 
The process runs and throws an error at the end.  
Display the generated IMG output. The recoded image values appear as 
expected. Select Raster tab > *Table*. Then *Show Attributes*. The first three 
original rows from the input TIFF attribute table, but with NO Histogram column, 
are saved to the IMG output image. Calculating statistics of the IMG file using 
Metadata seems to repair the attribute table to the expected table result.  

00058219  Raster Thematic Recode does not 
write TIFF output using specific TIFF 
input data  

Raster Thematic Recode does not write TIFF output using specific TIFF input 
data  
Problem can be recreated with provided data but is not seen with every input 
file. Recode generates TIFF output using other TIFF and IMG input files. The 
sample input TIFF image is reportedly generated downstream from other 
IMAGINE 2020 processes. Recode does write IMG output using the same TIFF 
input.  
To recreate:  
1. Run Thematic Recode  
2. Input File: \\alpha\JIRA_data\IM-52608\wv2_4007_recode_3class_stk_v2.tif  
3. Select Set Recode…  
4. Select Row Value = 2, Enter New Value = 1, then Change Selected Rows  
5. Select OK to dismiss Thematic Recode dialogue  
6. Select Output File icon  
7. Change Files of Type to ’TIFF’  
8. Enter output filename  
9. Then OK  
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Progress meter shows successful completion of multiple subtasks, but error is 
thrown at the end  
No TIFF output is generated  

00056784  Recode result is incorrect when 
output data values exceed bit-depth 
of input  

When recoding data and the output data has a larger bit depth than the input 
(e.g. recoding from u4 bit to u16 bit, i.e., changing pixel value 3 to 300) the new 
values that are greater than 4-bits are not added to the attribute table, i.e., the 
attribute table of the output 16-bit data has the same number of rows as the 
input 4-bit data but the new values are not mapped correctly. The new values 
that are greater than 4-bits get combined into the last row of the attribute table. 
If you use the Inquire Cursor to inspect the recoded image you can observe 
that the new recoded pixel values are written to the file.  
Steps to reproduce the issue:  
1. Open the Recode tool (Raster tab > Thematic menu > Recode)  
2. Select the attached file lnlandc.img as the input and enter a name for output 
file.  
3. Set the output data type to Unsigned 16-bit.  
4. Click the Setup Recode button to display the Thematic Recode dialog.  
5. Use the following values in the New Value column: 0, 1, 2, 250, 300, 305, 
306, 307, 308, 309, 310.  
6. Click OK in the Setup Recode dialog.  
7. Click OK in the Recode tool.  
8. Display the recoded image in a 2D View and open the attribute table to 
observe that the there is still only 11 rows. Any rows that were recoded with a 
value higher than 10 get squashed into the 10^th^ row.  
9. Use the Inquire Cursor to check the actual pixel values in the image and 
observe that the pixel values have in fact been changed.  
 
This process works correctly with the Recode tool in ERDAS IMAGINE 2018.  

00067176, 
00057021  

3D Measure tools do not work 
consistently  

The 3D measuring tools usually work the first time they are started in an 
ERDAS IMAGINE session, but the tools become inconsistent after you close 
and reopen the 3D View. It is difficult to reproduce consistently, but it seems to 
happen when you close the 3D View and then show the point cloud in 3D again 
(without removing the point cloud data from the 2D View). The first time the 
point cloud data is shown in the 3D View the 3D measure tools work, but after 
closing and reopening the 3D View the 3D measure tools to not respond  
To reproduce the problem:  
1. Display point cloud file “1815.las” in 2D View.  
2. Display point cloud in 3D.  
3. Click inside 3D View to ensure that view is selected.  
4. Turn on 3D measurement tool (Measure Point) and click in 3D View to 
measure a point…success!  
5. Without doing anything else, close the 3D View.  
6. Display point cloud in 3D again.  
7. Click inside 3D View to ensure that view is selected.  
8. Turn on 3D measurement tool (Measure Point) …nothing happens. 1. Open 
ps_napp.img in 2D View  
2. Run Panchromatic tab>Transform & Orthocorrect group > Control Points  
3. Select Camera geometric model  
4. In GCP tool pick GCP file and select ps_camera.gcc  
5. Within Camera Model Properties windows, select ps_dem.img as an 
Elevation Source. Click Yes to All for the notification message.  
6. Click Save As to save geometric model. Provide filename and click OK. 
Multipoint Geometric Correction tool will crash.  
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00069944  Control points crashes trying to save 
camera .gms  

This issue is present in ERDAS IMAGINE 2020 (build 1366) 64-bit, 32-bit 
version works fine as well as ERDAS IMAGINE 2018 64-bit/32-bit.  
To reproduce with attached data:  

00061258  “Make TOC” program for RPF data 
gives ERROR: Invalid index or value 
expression!  

This has been reported by a customer in Canada  
Make sure there are no existing A.TOC files in 
\\alpha\Teamspace\args\Ian\RPF_Ian  
Call Manage Data tab > NITF/NSIF group > Make RPF ToC  
Specify a file in the directory \\alpha\Teamspace\args\Ian\RPF_Ian  
Click Make TOC  
Error  
Invalid index or value expression  
[OK] [OK to All]  
...but if you OK that dialog the A.TOC seems to be created.  
Customer reports that this started happening at v16.5.1.  
12/03/20 13:18:15 eWkspace_64(40824): Loading [makerpftoc.eml]...  
12/03/20 13:19:51 SessionMgr(32192): ERROR: #5083 from 
eeci_SingleStepCode  
12/03/20 13:19:51 SessionMgr(32192): ERROR: Problem occurred while 
executing script from C:/Program Files/Hexagon/ERDAS IMAGINE 
2020/scripts/makerpftoc.eml at line 71  
12/03/20 13:19:51 SessionMgr(32192): ERROR: #4 from eeci_PopSetArray  
12/03/20 13:19:51 SessionMgr(32192): ERROR: Invalid index or value 
expression!  
12/03/20 13:19:51 eWkspace_64(40824): Writing File c:/temp/attd40824  
12/03/20 13:19:51 C:/Program Files/Hexagon/ERDAS IMAGINE 
2020/bin/x64URelease/maketoc.exe c:/temp/attd40824 
//alpha/teamspace/args/ian/rpf_ian/a.toc 1  
12/03/20 13:19:51 eWkspace_64(40824): Unloading [makerpftoc.eml]...  
12/03/20 13:20:07 SessionMgr(32192): maketoc.exe exited normally.  

00022515  Surface Difference produces 
unexpected results in elevation 
difference statistics when Ignore 
Value and Skip is in use  

If you run Surface Difference using the default preference for Image File 
(General) Continuous Statistics Coverage percent = 0.0. The resulting report 
file and image statistics are invalid. If the default is changed to Continuous 
Statistics Coverage percent = 100.0 the expected report file and image 
statistics are correct. In both cases, the raster difference image from the test 
model is correct .  
In the test case, the REFERENCE and TEST raster inputs are copies of the 
same raster, meaning zero difference is expected to be reflected in the report 
results.  
Continuous Statistics Coverage percent = 0.0  
Minimum difference = -24575.25  
Maximum difference = 0  
Mean of difference = -5.840242359086706  
Std Deviation of difference = 378.796596183834  
Median of difference = -0.7499771118164063  
Mode of difference = -0.7499771118164063  
LE90 = 0.7499771118164063  
Continuous Statistics Coverage percent = 100.0  
Minimum difference = 0  
Maximum difference = 0  
Mean of difference = 0  
Std Deviation of difference = 0  
Median of difference = 0  
Mode of difference = 0  
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00013124  MosaicPro Sort Images affects 
polygon holes  

MosaicPro may get a seamline polygon hole (missing a whole single aerial 
image), depending on which direction you Sort Images according to Image 
Name, before redoing Most Nadir Seamlines.  
Note that when you sort images descending and then generate seams, I don't 
see the island polygons.  

00040917  Grayscale TIFF output from 
MosaicPro has TIFF Tag for 
PhotometricInterpretation set to 
RGB  

When outputting single-band grayscale TIFF data from MosaicPro 2020 the 
output TIFF data has its TIFF tag value for PhotometricInterpretation set to 
“RGB”. It should be set to “Min Value is Black”. ERDAS IMAGINE 2018 sets 
this TIFF tag value to “Min Value is Black”.  
To reproduce the problem:  
1. Start MosaicPro 2020.  
2. Add the image “vers2018_n6212a.tif”.  
3. Run the mosaic process outputting to TIFF format.  
 

00060262  MosaicPro output shows seam gap 
between overlapping images  

MosaicPro writes a 1-pixel seam gap (value 0) between images that have 
overlapping borders. This gap is not seen in ERDAS IMAGINE 2018 when 
using the same MosaicPro options.  

00058430  Weighted seamlines crash 
MosaicPro in ERDAS IMAGINE 
2020  

Replicated crash using a dataset with 220+ ortho images.  
It looks like it is calculating seamlines for each image, but when it gets to 
Generating Seamlines, the application will crash.  
"Cutline refine error. No next vertex found for Intersect " error messages are 
observed in the session log.  
But with the same dataset version 2018 works fine.  

00056559  MosaicPro will not stitch adjacent 
tiles together for some images  

Two adjacent side by side tiles can be displayed in the viewer. After 
mosaicking the two images together using MosaicPro, only one image is 
written in the mosaic output.  
The output image extent window is written for both images, but the output only 
contains pixel values from one image.  

00060084, 
00054862  

Point Cloud Metadata tool crashes 
when assigning projection 
information to LAS file  

The Point Cloud Metadata tool crashes when attempting to assign projection 
information to a LAS file.  
1. Start the Point Cloud Metadata tool and open the attached file “no_pro.las”.  
2. Click on the Edit menu and select Add/Change Projection.  
3. In the Projection Chooser set the projection to UTM GRS 1980 NAD83 
North, UTM Zone 18 and click OK.  
4. The Point Cloud Metadata tool crashes and the projection information is not 
added to the LAS file.  
 
The ERDAS IMAGINE Session log reports “pointcloudinfo.exe exited with 
status -1073740791.”  
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00060084  Point Cloud Tools > Commands: 
Options to set the Elevation Info is 
not operational in 64-bit version  

This issue is seen in ERDAS IMAGINE 2020 64-bit.  
To Reproduce:  
1. Run ERDAS IMAGINE 2020 64-bit > Terrain tab > Point Cloud Tools > 
Commands  
2. Select .las file provided  
3. Activate Add/Change Elevation Information and click Options...  
 

00054761  Point cloud data does not display 
with OpenStreetMap basemap  

When displaying point cloud data over the OpenStreetMap basemap in a 2D 
View the point cloud data disappears and only a red boundary box is displayed.  
Steps to reproduce the problem:  
1. Start ERDAS IMAGINE 2020 64-bit  
2. Display the point cloud file provided in a 2D View.  
3. Display the OpenStreetMap basemap in the same 2D View. The point cloud 
layer is no longer displayed, but its boundary is defined by a red box.  
 

00054761  Point cloud data displayed over 
OpenStreetMap basemap crashes 
ERDAS IMAGINE  

RDAS IMAGINE 2020 64-bit will crash after displaying point cloud data over 
the OpenStreetMap basemap and then panning and zooming in the 2D View.  
Steps to reproduce the problem:  
1. Start ERDAS IMAGINE 2020 64-bit  
2. Display the point cloud file provided in a 2D View.  
3. Display the OpenStreetMap basemap in the same 2D View. The point cloud 
layer is no longer displayed, but its boundary is defined by a red box.  
4. Close the point cloud layer by right-clicking on its name in the Contents 
panel and selecting Remove Layer.  
5. Pan and zoom a little bit in the 2D View with OpenStreetMap basemap still 
displayed.  
 

00043191  HPF Pansharpening process gives 
error message: "efio_fread failed" if 
the Panchromatic data size is bigger 
than 4GB created by GDAL  

Customer reported that HPF Pansharpenning doesn’t work. While performing 
HPF Pansharpenning , ERDAS IMAGINE gives the following error messages: 
"efio_fread failed". The customer found that similar panchromatic image size 
less than 4GB, ERDAS IMAGINE completes the process and results are good.  
Error message : "efio_fread failed" during the HPF PanSharpening process.  
BigTIFF files (> 4GB) created by packages other than GDAL appeared to work 
fine.  

00046034  Warptool is unable to resample 271 
band Headwall Hyperspectral data in 
ENVI hdr format or as the imported 
*img format  

Customer reported that Warptool is unable to resample 271 band Headwall 
Hyperspectral data.  

00062719  Warptool Camera model aborts 
when resample process is run with 
specific data  

To recreate:  
1. Display input raster ‘foto_input.img’.  
2. Panchromatic tab > Transform group > Control Points  
3. Select Saved Model > Camera model, then OK  
4. Load Geometric Model ‘camera_es5.gms’  
5. Substitute local file ‘dem.img’.  
6. GCP Tool opens > select GCP File (.gcc) , then OK > from File Chooser 
select ‘coordinate_reference.gcc’, then OK  
7. Select Close  
8. Select Solve Geometric icon  
9. Select Resample > enter output filename  
10. Then select OK to run  
 
Warptool crashes with error:  
14/04/20 16:31:33 SessionMgr(27236): warptool.exe exited with status -
1073741819.  
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Same process using same steps works in ERDAS IMAGINE 2018.  

00039282  Export CADRG will not write files 
into folder name containing the 
character ‘ö’  

Export CADRG fails to write RFP frames to a folder name containing special 
character ö. Problem is not seen with other special characters å and ä.  

00061258  Make RPF TOC fails when 
attempting to create TOC file to 
mapped network drive  

The Make RPF TOC fails when attempting to create TOC file across network.  
1. Map network drive W: pointing to a UNC network location.  
2. Make sure there are no existing A.TOC files in W:\CAN_VFR_250K.  
3. Open the Make RPF TOC tool (ERDAS IMAGINE 2020 > Manage Data tab 
> NITF/NSIF group > Make RPF TOC).  
4. Select the RPF directory W:\CAN_VFR_250K as the location to create the 
A.TOC file.  
5. Click the Make TOC button.  
6. The error message “Invalid index or value expression” pops up (see linked 
bug), but if you click OK the process continues.  
7. The Process List reports the status “Parsing Attribute File” and the progress 
meter sits at 20% until it eventually fails.  
 

00050423, 
00041391, 
00050423  

Better DSM results needed from 
Semi-Global Matching (SGM)  

Elevation data extracted from stereo imagery pairs using SGM was not as good 
as expected.  

00068281, 
00066818  

3D ASCII file causes error when 
adding DTM to Terrain Prep Tool  

A 3D ASCII file (*.xyz) that does not have negative X and Y coordinates will 
cause error when loading it into the Terrain Prep Tool. The error is:  
Incorrect object type when accessing key "URL"  
The same 3D ASCII files that cause this error in ERDAS IMAGINE 2020 can be 
loaded into ERDAS IMAGINE 2018’s Terrain Prep Tool without any problems.  
Steps to reproduce the problem:  
1. Start the Terrain Prep Tool.  
2. Click the button for “Add DTM files to the list”.  
3. Set the file type to “3D ASCII (*.xyz)”.  
4. Select the provided file “3d_point_data.xyz” and the errors display  
 

00016717  ECRG exporter does not write EPF 
frames with some data (thematic not 
a valid input)  

The ECGR exporter was allowing non-RGB imagery to be input and spend time 
processing it even though it is not a valid input.  
The exporter needs enhancing to disallow inputting non-RGB imagery.  

   

IMAGINE Objective 
Issue ID  Summary – IMAGINE Objective  Description / How to Reproduce  
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00066419  Typo in Association:Shadow VOP 
help documentation  

There is a minor typo in the Help documentation for the Vector Object 
Processor Association:Shadow. Towards the bottom of the page it says:  
This cue metric is useful for classifying objects that case visible shadows such 
as buildings, trees, targets, etc.  
It should say “cast” instead of “case.”  

00062294  IMAGINE Objective crashes when 
adding Raster Pixel Processor 
queues to project on system without 
Java installed  

IMAGINE Objective crashes when adding raster pixel processor queues to 
Objective project.  
To recreate  
1. Launch IMAGINE Objective  
2. Dismiss the Attention warning dialogues indicating java Runtime 
Environment is missing  
3. Create new Project and new Feature Model  
4. Add New Variable of Raster type (residential.img), then click OK  
5. Expand Project treeview and select Raster Pixel Processor  
6. In the Properties panel > Properties tab, select Identity from the Pixel ques 
list > then click the Add button + the properties tab.  
 
You should see the crash  
0/10/19 15:03:42 fe_workstation(5008): Exiting all editors  
30/10/19 15:03:42 fe_workstation(5008): Opened layer 
c:/data/temp/residential.img(:Layer_1)  
30/10/19 15:04:11 SessionMgr(4356): fe_workstation.exe exited with status -
1073741819.  
Crash does not occur after installing Java Runtime environment v8u202.  

00009668  sentinel2.dll error when running 
IMAGINE Objective Vector Cleanup 
Operator  

When running an IMAGINE Objective project with just a Vector Cleanup 
Operator it caused an error stating “Could not load DLL  
D:\program_files\IMAGINE2016\usr\lib\x64URelease\RasterFormats\sentinel2
.dll: Unknown error code – 127”.  
The process runs to completion and the output file is created successfully. 
Error message about the sentinel2.dll seems unrelated to the actual issue.  

00012292  Dilate Raster Object Operator does 
not dilate complete image coverage  

Dilate Raster Object Operator does not dilate the total image area for all 
classes. In the specific example project, the dilation does not extend through 
the total image for a specific class. Other classes appear to be dilated through 
the complete image extent.  

00009384  Different results for output based on 
simple change in manner of 
processing  

If the user processes Objective by doing half the processing, and then 
completes the processing from the point they first stopped, the resulting output 
is different from the output if they just let the entire process run. The resulting 
polygons are different. There are polygons missing.  

 

 

IMAGINE Photogrammetry  
Issue ID  Summary – IMAGINE 

Photogrammetry  
Description / How to Reproduce  

00046100  Import tool imports INPHO project 
with wrong flying height  

When importing Inpho project to block file; at project import default unit is 
meters, and when you enter units as US Survey Feet importer makes a 
conversion from meters to US Survey feet which it shouldn’t because project is 
triangulated in US Survey feet. Defining the INPHO projection units should not 
result in unit conversion.  

00067721  PYRX pyramids not recognized as 
existent in IMAGINE 
Photogrammetry  

When computing PYRX pyramids for use within IMAGINE Photogrammetry, 
they are not recognized as existent (green color) in the column "Pyr". 
However, the ViewPlex of the Terrain Editor and PRO600 is apparently able to 
work with the PYRX pyramids.  

00058613  APM Crashing with ORIMA 2020  APM fails with projects containing 1000 to 3000 images or more.  
00041391  XPro SGM has problems with new 

Vexcel sensor, Mark III  
Several problems observed with new camera from Vexcel, the Mark III. This 
new sensor has an extreme high resolution, which allows the aerial 
photogrammetric companies to fly much higher than before and still get the 
same ground-pixel resolution.  
The camera generates such high resolution images, that AutoDTM has 
problems processing them. XPro requires to generate new TIF images, but 
these are not recognized afterwards.  
These issues are addressed by using IMAGINE DSM Extractor.  

00050423  DSM generated by  
IMAGINE Photogrammetry  
against DSM generated by  
another software vendor  

Tridicon SGM was producing results which were not comparable in quality to 
some other software vendors using WorldView-3 imagery.  
These issues are addressed by using IMAGINE DSM Extractor.  
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IMAGINE Professional 
Issue ID  Summary – IMAGINE Professional  Description / How to Reproduce  
00070492, 
00070356, 
00067255 , 
00062666, 
00062056, 
00061236, 
00061293  

Accuracy Assessment tool truncates 
reference values  

When manually entering values in the Reference column of the Accuracy 
Assessment tool the digit in the ones decimal place gets removed. For 
example, entering a value between 0-9 becomes 0, while 15 becomes 1, 25 
becomes 2, 255 becomes 25, etc.  
1. Start the Accuracy Assessment tool (Raster tab > Classification group > 
Supervised > Accuracy Assessment)  
2. Open the attached raster image eldoatm_class25.img (File menu > Open).  
3. Create random points (Edit menu > Create/Add Random Points)  
4. Number of Points: 10  
5. Distribution Parameters: Random  
6. Show the class values (Edit menu > Show Class Values).  
7. For row 1 enter value 1 in Reference column. It becomes 0.  
8. For row 2 enter value 22 in the Reference column. It becomes 2.  
 

00049855  Area Frame Sampling Project 
Manager corrupts image paths of 
saved projects  

Area Frame Sampling Project Manager corrupts the image paths of saved 
projects. Customer reports this works in ERDAS IMAGINE 2011. Problem is 
seen in ERDAS IMAGINE 2016 and ERDAS IMAGINE 2018.  
Image file paths are added to the Area Frame Sampling project during 
construction. These pathnames are corrupted after saving and reopening the 
project. The path of the project file (.spf) is inserted before the path of the 
project images.  
Example image file path and name while building the project:  
C:\temp\lnsoils.img  
Example image file path and name after saving and reopening the project:  
C:\Data\SFDC\00049855_frame_sampling\C:\temp\lnsoils.img  
The only workaround is to reinsert the images into the project after reopening 
the project. Basically, rebuilding the project.  

00067397  Detect Objects Using Deep Learning 
producing shifted output (when 
coordinates go down by Y axis from 
origin?)  

Working with the material from this demo: 
https://community.hexagongeospatial.com/t5/Spatial-Modeler-
Tutorials/Mapping-Oil-Palms-using-Deep-Learning-Object-Detection/ta-
p/38259 If BuildingFootprints_SpatialJoin_Damage_NE_Subset is run against 
the training tile BuildingFootprints_SpatialJoin_Damage_NE_Subset the 
shapefile output does not properly overlay on the raster input.  
The produced shapefile output will be shifted, so that upper left Y from the 
image becomes lower right in shapefile.  

00068354  Help references the 'ML Model' 
menu name used in the 2018 
Machine Layout interface  

Machine Layout model pull down menu name was changed to Machine 
Intellect in ERDAS IMAGINE 2020. Machine Layout Online documentation 
references the ERDAS IMAGINE 2018 interface name ML Model. There are 
multiple references of ML Model listed in the Online documentation.  

 

 

   

Spatial Modeler  
Issue ID  Summary – Spatial Modeler  Description / How to Reproduce  
00046042  Union Features states it accepts 

Lists (of Features), but it does not  
The Help for Union Features states the following:  
However, if you try to feed a List of Features to the FeaturesIn1 port it will fail 
with the following message:  
Spatial Model failed in Union Features 2. The error was  
"HexagonGeospatial::FeatureAnalysis::UnionFeaturesOperator::OnExecute  
failed  
No input features found.".  

00054184  Classify Using Machine Learning 
workflow generates no classes with 
Pseudo Mercator data  

Classify Using Machine Learning workflow will generate empty classes (i.e. 
min=0, max=0) in the classified output raster if the projection of the training 
input raster is registered to projection: Pseudo Mercator, Spheroid/Datum: 
WGS84, EPSG Code: 3857.  
Classify Machine Using Machine Learning workflow will generate expected 
number of classes (i.e. min=0, max=4) in the classified output raster if the 
projection of the training input raster is registered to another projection: UTM 
Zone 36, Spheroid/Datum: WGS84, EPSG Code: 32636).  
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00061099  Classify Using Machine Learning 
fails with error: Buffer dtype 
mismatch, expected 'SIZE_t' but got 
'long'  

To reproduce run the classify_using_machine_learning.gmdx model with 
associated subset_1.img input image and trainingwaternietwater.miz.  
Initially partner has reported that this issue can be reproduced when running 
the process only in Batch mode, but it can be replicated on some computers 
via Run.  
It fails with the below error in ERDAS IMAGINE 2020 32-bit/64-bit and in 
ERDAS IMAGINE 2018 64-bit:  
10/03/20 15:54:42 SessionMgr(14920): Connection success for the external 
process 'eWkspace_64'  
10/03/20 15:57:54 SessionMgr(14920): Executing spatial model: 
d:/0sfdc/83machinelearning/classify_using_machine_learning.gmdx  
10/03/20 16:08:19 SessionMgr(14920): Running command line: C:/Program 
Files/Hexagon/ERDAS IMAGINE 2020/bin/x64URelease/mlpywrapper.exe 
"C:/Program Files/Hexagon/ERDAS IMAGINE 
2020/etc/MachineLearning/Operators/randomforestpredictraster.py" 
"d:/temp/SM-2  
7a7-d52f-3c06-3c41-002344/mlpy_jsoninput_4513b634-8662-4c89-bc1a-
cd0887c4593d.Json" "d:/temp/SM-27a7-d52f-3c06-3c41-
002344/mlpy_jsonoutput_ef7ccef4-a66b-4877-ad61-db6dcd8b95dd.Json" 
\\.\pipe\6786d301-5f4e-45f4-be7c-8942640df7fa  
10/03/20 16:08:47 SessionMgr(14920): Error occured while running 
randomforestpredictraster  
10/03/20 16:08:47 SessionMgr(14920): Buffer dtype mismatch, expected 
'SIZE_t' but got 'long'  
10/03/20 16:08:47 SessionMgr(14920): 
D:\TEMP_MEI160602\sklearn\base.py:315: UserWarning: Trying to unpickle 
estimator LabelEncoder from version 0.18.1 when using version 0.18.2. This 
might lead to breaking code or invalid results. Use at your own risk.  
10/03/20 16:08:47 SessionMgr(14920): 
D:\TEMP_MEI160602\sklearn\base.py:315: UserWarning: Trying to unpickle 
estimator DecisionTreeClassifier from version 0.18.1 when using version 
0.18.2. This might lead to breaking code or invalid results. Use at your  
own risk.  
10/03/20 16:08:55 SessionMgr(14920): Could not understand JSON for type: 
IMAGINE.File  
10/03/20 16:08:55 SessionMgr(14920): Spatial model execution failed.  
10/03/20 16:19:25 SessionMgr(14920): external process exited with status 1.  
Only ERDAS IMAGINE 2018 32-bit executes this model successfully. Have 
placed Replace NoData With operator due to the defined limitation for 
Classify Using Machine Learning operator. However, ERDAS IMAGINE 2018 
32-bit successfully executes this model even with original data that has 
NoData pixels.  

00070615, 
00070399, 
00069009, 
00060855, 
00056785  

Changing input file in legacy model 
(.gmd) does not correctly update the 
function definition  

If you change one of the input files in a model it does not update the input file 
in the function definition correctly. Instead, it attaches the new input file name 
to the original input file name. For example, if you have a model which adds 
two input raster files together the initial function definition looks like 
“$n1_input_one + $n2_input_two”, but if you go back and change the input 
file from “input_two.img” to “input_three.img” and check the function definition 
again it now looks like “$n1_input_one + $n2_input_twon2_input_three”. It 
does not remove the original input file name, and this causes the model to 
crash.  
This only occurs in the 64-bit version of ERDAS IMAGINE 2020 Update 1. 
The problem does not happen in the 32-bit version of ERDAS IMAGINE 2020 
Update 1 or in ERDAS IMAGINE 2018  

00059887  ModelMaker: Function Definition 
doesn't properly update predefined 
band selection with values from new 
image  

This works properly in ERDAS IMAGINE 2018. To reproduce issue in 
ERDAS IMAGINE 16.6 build 1366:  
1. Open attached cb1.gmd in Model Maker  
2. Double-click on Function, which will be shown as:  
EITHER 10000 IF ( ($n1_w10_20181120(7)==-10000) OR 
($n1_w10_20181120(8)==-10000) OR ($n1_w10_20181120(9)==-10000 )) 
OR ($n1_w10_20181120(8)$n1_w10_20181120(7) 
$n1_w10_20181120(9))0.001$n1_w10_20181120(7)*0.001(702-667)/(742-
667) OTHERWISE  
3. Close Function Definition. Double-click on Input Raster and pick input.img 
file (attached).  
Function will be updated to an invalid one:  
EITHER 10000 IF ( ($n1_w10_20181120(7)==-n1_input(7)==-10000) OR 
($n1_w10_20181120(8)n1_input(8)==-10000) OR 
($n1_w10_20181120(9)n1_input(9)==-10000 )) OR 
($n1_w10_20181120(8)$n1_input(8)$n1_w1n1_input(7) -
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$n1_w10n1_input(9))0.001$n1_w10_20181n1_input(7)*0.001(702-667)/(742-
667) OTHERWISE  
In ERDAS IMAGINE 2018 it properly changes to new values:  
EITHER 10000 IF ( ($n1_input(7)==-10000) OR ($n1_input(8)==-10000) OR 
($n1_input(9)==-10000 )) OR ($n1_input(8)$n1_input(7) 
$n1_input(9))0.001$n1_input(7)*0.001(702-667)/(742-667) OTHERWISE  

00060343  Problems reading stats should not 
cause Raster Input to fail  

IMG format files downloaded from USGS website have StatisticsParameters 
that are incorrectly written which cause RasterInput to fail. This should be 
corrected.  

00058591  Join Features operator: Select 
Attribute doesn't provide full list of 
attributes from Join Features result  

To reproduce:  
1. Open provided model  
2. Double-click on Attribute Name port of Select Attribute operator. Notice 
that Corine_R attribute is not present  
3. Double-click on Attribute Names of Select Attributes operator. Notice that 
Corine_R attribute is there  
4. Manually type in the Corine_R attribute to the Attribute Name port of Select 
Attribute operator. Right-click on Select Attribute operator and pick Run Just 
This. Notice that it will output this attribute  
 

00058591  Join Features operator: Doesn't 
output attributes from features with 
no geometry  

Run original attribute_join_original.gmdx model with provided data. It will 
output attributes from the Left features only without matching attributes from 
Right.  

00068887  Shapefile created with GDAL - 
Projection not recognized in Spatial 
Modeler  

Error message that gets displayed in Spatial Model Editor is: “Dimensionality 
of CRS cannot be determined”.  
Session log adds: Failed to recognize Authority Code with Authority "PRJ" 
and Authority Code 
"D:/tmp/kws/problems_imagine2020u1/computed/searchArea.prj"  

00069509  Spatial Model fails when reprojecting 
from EPSG:4326 to EPSG:32632  

When using a spatial model to reproject a global DEM from EPSG:4326 to 
EPSG:32632 and subsetting the output to match the extent of a smaller 
reference image the process fails. E.g. when attempting to subset and 
reproject from a global DEM in EPSG:4326 to an area matching a reference 
image in EPSG:32632.  
Spatial Model Editor reports the following messages:  
Raster Input: Pixel Block Request failed: EFGA_DERIVEPOLYCOEFS failed  
Raster Output: Unknown exception. (`anonymous-
namespace'::AsyncReadImpl::get_Result failed 
erdas::sblegacylib::PortGriddedDataSource::Read failed  
Session log shows these errors:  
1/10/20 13:20:12 SessionMgr(24476): Executing spatial model: 
d:/tickets/00069509/reproject_resample_raster.gmdx  
01/10/20 13:20:12 SessionMgr(24476): Unable to extract EPSG code from 
CRS with title 'ps1'; ignored  
01/10/20 13:20:12 SessionMgr(24476): Unable to extract EPSG code from 
CRS with title 'g1674'; ignored  
01/10/20 13:20:14 SessionMgr(24476): ERROR: #950 from 
eirf::ImageWarper::Impl::GeometricTransMagGet  
01/10/20 13:20:14 SessionMgr(24476): ERROR: 
EFGA_DERIVEPOLYCOEFS failed  
01/10/20 13:20:14 SessionMgr(24476): ERROR: #4 from 
EFGA_DERIVEPOLYCOEFS  
01/10/20 13:20:14 SessionMgr(24476): ERROR: EFGA_SOLVELINEAREQS 
failed  
01/10/20 13:20:14 SessionMgr(24476): ERROR: #4 from 
EFGA_SOLVELINEAREQS  
01/10/20 13:20:14 SessionMgr(24476): ERROR: egda_MatrixDivide failed  
01/10/20 13:20:14 SessionMgr(24476): ERROR: #6 from egda_MatrixDivide  
01/10/20 13:20:14 SessionMgr(24476): ERROR: egda_MatrixDivideF64 
failed  
01/10/20 13:20:14 SessionMgr(24476): ERROR: #2 from 
egda_MatrixDivideF64  
01/10/20 13:20:14 SessionMgr(24476): ERROR: 
egda_MatrixLUDecomposition failed  
01/10/20 13:20:14 SessionMgr(24476): ERROR: #7 from 
egda_MatrixLUDecomposition  
01/10/20 13:20:14 SessionMgr(24476): ERROR: 
egda_MatrixLUDecompositionF64 failed  
01/10/20 13:20:14 SessionMgr(24476): ERROR: #1 from 
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egda_MatrixLUDecompositionF64  

00045305  Creating submodels may displace 
annotation and operator layout  

Creating submodels from relatively complex models displaces the layout of 
text annotation and operators in the model.  
Product Manager observed similar model behavior when creating submodels 
and reports the amount of shifting correlates with the complexity of the 
model. The more complex the model, the greater the displacement of 
operators and text.  

00052363  Running a model from the Ribbon 
will fail when using Map Boundary 
port  

Running a model from the ribbon (e.g. Launch Spatial Model, My Models) will 
fail if the Map Boundary port coordinates are defined using the Inquire Box. 
Defining the Map Boundary by manual keyboard entry will work. Same model 
runs successfully using the Inquire Box if it’s run from the Spatial Model 
Editor window.  
Model errors:  
24/09/19 10:20:50 Spatial Model failed in Raster Input. The error was 
"erdas::sb_raster::RasterInput::ResolveBBox failed  
24/09/19 10:20:50 Bounds do not intersect image".  
24/09/19 10:20:50 SessionMgr(34428): Spatial model failed.  
24/09/19 10:20:50  
24/09/19 10:20:51 SessionMgr(34428): smprocess.exe exited with status 1.  
Running the model from Spatial Model Editor using same model parameters 
from above will run successfully.  

00050531  Schema Remodeler "Rename 
Attributes" is dropping coordinate 
system ID resulting in error  

Schema Remodeler "Rename Attributes" is dropping coordinate system ID 
resulting in the following error.  
System Model failed in Union Features. The error was "The input geometry 
field 'Geometry' does not have a valid CoordinateReferenceSystemld. The 
input geometry cannot be transformed to target CRS without a known source 
CRS"  
It appears the "Rename Attributes" operator is dropping the coordinate 
system ID.  

00064086, 
00048695  

Spatial Model changes datum of 
input feature data  

When processing input feature data that are projected to Lambert Conformal 
Conic with the datum “MGI AT (EPSG: 1618)”, the output features and raster 
data have a different datum which causes a shift of approximately 300 meters 
in the X-direction. The output features data are assigned the datum “MGI”. 
The output raster data is assigned the datum “Militar-Geographische Insttut 
[To WGS 84 8]”.  

00051840  Encode Height to Vertex Z spatial 
model is giving Z values all 0 with 
ESRI asc input file  

Customer reported that they have created a spatial model on the basis of the 
following Encode Height to Vertex Z spatial model:  
https://community.hexagongeospatial.com/t5/Spatial-Modeler-
Tutorials/Encode-Height-to-Vertex-Z/ta-p/26083  
If the customer runs the model with asc file as input, the model successfully 
ran and generated output shapefile. However, the geometry 'z' were all 0.  
Running the same model with a tif raster DEM, the geometry 'z' gets 
populated.  

00060388  Error in Spatial Modeler with 
GeoPackage dataset (containing 
features)  

To Reproduce:  
1. Run Toolbox tab > Spatial Model Editor  
2. Add Features Input operator  
3. Double-click on Filename port  
4. Pick GeoPackage Features Proxy (*.gfb) and click Connect.  
5. In the GeoPackage Data Source window browse for data.gpkg (provided) 
and provide the name  
6. When you will select this data in Database Connections section, the error 
shows up saying "unrecognized token: "2019xxxx"  
 
This data can be successfully opened in QGIS. However, other GIS 
applications throw the same error.  

00058909  Missing "Verify Save on Close" 
dialogue when closing the Spatial 
Model Editor after editing text 
annotations  

To reproduce:  
1. Open provided test.gmdx  
2. Edit the annotation text.  
3. Close Spatial Model Editor. It will not offer to save edits and close the 
Editor window. As a result - no edits saved.  

00065622, 
00058966  

Classify Ground operator may crash 
Spatial Modeler  

A customer reports that Spatial Modeler is crashing when running a model 
containing the Classify Ground operator. They provided a dump file that 
indicates the cause is heap corruption during parallel processing of points.  
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00063198  Apply Mask fails with binary data 
unless you pick the class via "Eq" 
operator  

If input.img is a u1 binary image, you should not require the Eq operator in a 
Spatial Model like this, which uses the Apply Mask operator: 

 
00070549  Spatial Modeler crashes when 

running with the Iterator operator  
Spatial Modeler crashes when working with the Iterator operator with a sub-
model that copies files from one folder to another if the model:  
1. Is run repeatedly (more than once)  
2. Clear Results is selected  
3. Try to delete any operator using the Delete key  
 
This problem is not observed running IMAGINE 2018 b1265  

00066469  Apply AOI operator fails 
unexpectedly with some AOIs  

Apply AOI operator fails with a customer supplied AOI (test.aoi). This same 
AOI works with other operators (e.g. Raster Input) and ERDAS IMAGINE 
programs (e.g. Subset). An AOI (hgd_1.aoi) that was manually screen 
digitized on top of the test image, works in the model.  
Session Log:  
16/07/20 16:45:45 SessionMgr(54660): Executing spatial model: 
//alpha/jira_data/im-54785/apply_aoi.gmdx  
16/07/20 16:45:46 SessionMgr(54660): 
HexGeo::SpatialModelerRaster::RasterUtils::BoxIntersection failed  
16/07/20 16:45:46 Images do not Intersect.  
16/07/20 16:45:46 SessionMgr(54660): Spatial model execution failed.  

00064752  Operator "Focal Sum" crashes 
Spatial Modeler when input data has 
NoData defined  

To reproduce run the focal_sum.gmdx model with provided data. The input 
data has NoData defined. Spatial Modeler will crash.  
The rest of Focal functions operate normally with that data, only Focal Sum 
leads to an application crash.  
If to replace NoData with valid value (e.g. 0), model will execute successfully.  

00067504  IMAGINE.Directory value is not the 
same across all operators (causes 
Path Exists to fail)  

Path Exists operator seems to accept string representation of 
IMAGINE.Directory object, but the value has to be in quotation marks (" ") .  
Port Input and Directory Input outputs IMAGINE.Directory value without 
those, so Path Exists fails with a "No appropriate data found on port(Path)." 
error.  
Get Containing Directory also outputs the IMAGINE.Directory, but in 
quotation marks, so Path Exists works, and also works when 
IMAGINE.Directory is first converted to String.  

00069394  Classify Using Deep Learning 
operator does not correctly 
remember its "complete" status for 
re-running downstream operations  

The provided Spatial Model takes an input NITF / BIIF image and runs a 
Deep Learning classifier to classify tiles that contain clouds. This is then used 
to estimate cloud cover.  
To reproduce the problem:  
1. Open the model in a Spatial Model Editor  
2. Start the Session Log  
3. Click Preview  
4. Wait for the deep learning to complete and the preview to show.  
5. Note that the Classify Using Deep Learning operator is checked green.  
6. Now pan to the tail end of the model, select the Report operator, right-click 
and select Run Just This  
7. Normally what you would expect to happen is for just those un-run 
operators to have to run. Anything that's upstream that has already 
completed should not have to be executed again.  
8. But Deep Learning classification starts all over again - you'll need to wait.  
 
As mentioned, only if something upstream of the Classify Using Deep 
Learning operator is modified would you expect anything downstream to be 
invalidated. In this instance we have not done that, so the Report should run 
in a matter of seconds.  
9. Now click Run  
10. Take all the defaults in the dialog again  
11. This should invalidate all the current results and start from scratch.  
12. But the model will fail  
13. That shouldn't happen either.  
 
At this point you need to quit and restart ERDAS IMAGINE otherwise Spatial 
Modeler just isn't going to run correctly.  

00003034  Spatial modeler Vector input 
operator cannot process shapefile 
with "-" in path  

The older Vector Input operator would not parse filenames that included the 
“-“ character. The replacement Features Input operator has no such 
limitations.  
Note that this change happened many versions ago but the Issue has only 
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recently been marked as Closed.  
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お問い合わせ  
  

  

https://go.hexagongeospatial.com/contact-us-today   

  

  

  

  

  

  

  

  

HEXAGONについて  
Hexagonはセンサー、ソフトウェア、自律型ソリューションの世界的リーダーです。産業、製造、インフ

ラ、安全、モビリティの各アプリケーションにおいて、効率、生産性、品質を高めるためにデータを活用し

ています。  

当社の技術は、都市と生産の生態系を形成し、ますます接続化と自律化が進み、スケーラブルで持続可能な

未来を確実なものにしています。  

Hexagonの地理空間部門は、過去、現在、可能性、あるべき姿、そして最終的には将来の姿を洞察した 5D

スマートデジタルリアリティを提供するソリューションを提供します。  

Hexagon (Nasdaq Stockholm: HEXA B) は 50カ国に約 21,000人の従業員を擁し、売上高は約 44億米ドルで

す。詳細は hexagon.comでご覧になり、@HexagonABをフォローしてください。  

  

    

 

 

 

 

 

 

 

 

 

https://go.hexagongeospatial.com/contact-us-today
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著作権  

© 2020 Hexagon ABおよび/またはその子会社と関連会社。すべての権利を保有しています。Hexagonは世界の多くの国で商標を登録し

ています。商標が登録されている国の情報については、商標ページ（http://www.hexagongeospatial.com/legal/trademarks）をご覧くださ

い。詳細については、製品ページと謝辞をご覧ください。  

製品ドキュメント 利用規約  

ヘキサゴンジオスパティアルのご利用の前に、これらの用語をよくお読みください。  

文書（以下「文書」という。この文書の使用は、変更なしで本契約の同意を表明します。あなたが本契約の条件（以下 "条件"）に同意し

ない場合は、この文書を使用しないでください。  

このドキュメントの使用  

本文書に含まれるすべての資料は著作権で保護されており、無断使用は世界の著作権、商標、およびその他の法律に違反する可能性があ

ります。本契約の条件に従い、Hexagon Geospatial (Intergraph Corporation の一部門) および Intergraph の子会社 (以下「Intergraph」) 

は、本契約により、お客様が個人的な非営利目的の使用に限り、本文書を複製することを許可するものとします。この許可の対価とし

て、お客様は、そこに含まれるすべての著作権およびその他の所有権表示を保持することに同意するものとします。お客様は、Hexagon 

Geospatialとの別個の契約で具体的に許可された場合を除き、いかなる方法であれ、本資料を修正したり、複製したり、公に表示した

り、実行したり、配布したり、またはその他の方法で公共または商業目的に使用したりすることはできません。  

前述の承認は、第三者の著作権表示または権利の帰属を示すコンテンツまたは資料を特に除外しています。上記で明示的に提供されてい

る場合を除き、ここに含まれるものは、Hexagon Geospatial、Intergraph、または第三者の著作権、特許、または商標に基づくライセン

スまたは権利を暗示、禁反言、またはその他の方法で付与するものと解釈されるものではありません。  

お客様がこれらの条件のいずれかに違反した場合、本ドキュメントを使用するお客様の権限は自動的に終了します。終了後、お客様は、

お客様が所有または管理しているダウンロードされたまたは印刷された資料を直ちに破棄するものとします。  

免責事項  

本資料で提供されるすべての資料は、「現状のまま」提供され、いかなる保証もありません。  

明示または黙示を問わず、以下を含むが、これに限定されるものではない。  

市販性、特定目的への適合性、または無保証の保証 

侵害。Hexagon Geospatialは、本文書の内容に誤りがないこと、欠陥が修正されること、または Hexagon Geospatialのウェブサイトま

たは資料を利用可能にするサービスにウイルスまたはその他の有害な成分がないことを保証するものではありません。  

Hexagon Geospatialは、この文書の正確性および完全性を保証するものではありません。Hexagon Geospatialは、予告なしにいつでも

この文書を変更することができます。  

責任の制限  

いかなる場合でも、Hexagon Geospatialは、いかなる直接的、間接的、偶発的な損害に対しても責任を負うものではありません。  

特別または必然的な損害、または利益、収益、収入、データまたは使用の損失に対する損害は、契約上または不法行為による訴訟である

かどうかにかかわらず、この文書へのアクセスまたは使用に起因して発生したものです。  

補償  

お客様は、お客様の本文書へのアクセスまたは使用に起因または関連して生じる、合理的な弁護士費用および費用を含む、あらゆる請

求、責任、損害、損失または費用から、Hexagon Geospatial、その役員、取締役、従業員、および代理人を防御し、補償し、損害を与え

ないことに同意するものとします。  

ソフトウェアの使用  

宛先不明の場合は、「送信」ボタンをクリックしてください。お客様は、エンドユーザー使用許諾契約を伴う、またはエンドユーザー使

用許諾契約を含むソフトウェアをダウンロードしたりインストールしたりすることは、お客様が当該使用許諾契約の条項を読み、承諾し

た場合を除き、できません。このようなソフトウェアは、Hexagon Geospatial、Intergraph、またはそのライセンサーの著作物です。ユ

ーザーインターフェースの一部の著作権は 2012- Telerik ADに帰属します。  

第三者のウェブサイトへのリンク  

この文書は、お客様の利便性と情報のために、第三者のウェブサイトへのリンクを提供する場合があります。第三者のウェブサイトは、

独自の利用規約に準拠します。Hexagon Geospatialは、リンク先の企業または製品を保証するものではありません。  

第三者のウェブサイトは、Hexagon Geospatialが管理していない独立した当事者によって所有および運営されています。Hexagon 

Geospatialは、お客様が第三者のウェブサイトを使用した結果生じるいかなる責任も負いません。第三者のウェブサイトへの、または第
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三者のウェブサイトからのリンクはすべてお客様自身のリスクであり、お客様が第三者のウェブサイトと共有する情報は、機密性、デー

タのプライバシー、およびセキュリティに関連するものを含め、第三者のウェブサイトの条件に従うものとします。  

商標について  

本書に表示されている商標、ロゴ、およびサービスマーク（「マーク」）は、Hexagon Geospatial、Intergraph、またはその他の第三者の

所有物です。ユーザーは、Hexagon Geospatial、Intergraph、またはマークを所有する第三者の書面による事前の同意なしにマークを使

用することはできません。"Intergraph"は、米国およびその他の国における Intergraph Corporationの登録商標です。その他のブランド名

および製品名は、それぞれの所有者の商標です。  

追加の商標情報を検索 https://www.hexagongeospatial.com/legal/trademarks。  

著作権侵害の主張をするための手続き  

著作権侵害を主張する通知は、Hexagon Geospatialに以下の住所に郵送してください。Intergraph Corporation, Attn: Intergraph Legal 

Department, P.O. Box 240000, Huntsville, Alabama 35824.  

米政府制限権  

資料は「制限付き権利」で提供されます。米国政府によるマテリアルの使用、複製、または開示は、FAR 52.227-14および DFARS 

252.227-7013 et seq.またはそれらの後継規定に規定されている制限に従います。政府による資料の使用は、Hexagon Geospatial または 

Intergraph の所有権を認めるものとします。  

国際利用  

お客様は、米国の輸出法および規制に違反して資料を使用または輸出することはできません。Hexagon Geospatialは、素材がすべての

国で適切または利用可能であることを表明するものではなく、素材の内容が違法である地域からのアクセスは禁止されています。  

Hexagon Geospatialは Hexagon Geospatialの国際データへのアクセスを提供しているため、お客様の国で発表されていない Hexagon 

Geospatialの製品、プログラム、およびサービスへの参照または相互参照を含む場合があります。これらの参照は、Hexagon Geospatial

がお客様の国でそのような製品、プログラム、またはサービスを発表することを意図していることを意味するものではありません。  

マテリアルは、米国の輸出管理および経済制裁に関する法律および規制の対象となり、お客様は、かかるすべての法律および規制を厳密

に遵守することに同意するものとします。さらに、お客様は、お客様が米国の経済制裁対象国（イラン、シリア、スーダン、キューバ、

北朝鮮を含みますが、これらに限定されません）の国民ではないこと、またはその国に居住していないこと、および米国の輸出管理およ

び経済制裁に関する法律および規制の下で、お客様が本資料の受領またはアクセスを禁止されていないことを表明し、保証するものとし

ます。Hexagon Geospatialは、本素材がすべての国で適切または利用可能であることを表明するものではなく、本素材のコンテンツが

違法である地域からの本素材へのアクセスは禁止されています。お客様が本契約の条件に従わない場合、かかる権利は失効することを条

件に、素材を使用するすべての権利が付与されます。  

改訂のご案内  

Hexagon Geospatialは、いつでも本利用規約を改訂する権利を留保します。お客様は、これらの条件を定期的に見直す責任がありま

す。このような変更の発効日以降、お客様がこの文書を継続的に使用することは、お客様がこのような変更を受諾し、これに同意したも

のとみなされます。  

適用法  

本文書は、アラバマ州の Hexagon Geospatialによって作成および管理されています。そのため、法の抵触の原則に影響を与えることな

く、アラバマ州の法律がこれらの条件に適用されます。お客様はここに、米国の排他的管轄権に従うことに取消不能かつ無条件で同意す

るものとします。  

本文書の使用に起因または関連する訴訟については、アラバマ州北部地区北東部地区地方裁判所、またはアラバマ州マディソン郡巡回裁

判所（およびこれらの裁判所以外でこれに関連する訴訟を開始しないことに同意するものとします）、これらの裁判所での当該訴訟の裁

判地設定に対する異議を放棄し、当該裁判所で提起された当該訴訟が不便な場所で提起されたことを主張または主張しないことに同意す

るものとします。法域によっては、本規約に定められた除外または制限を認めていない場合があります。このような除外または制限は、

すべての法域において、適用法によって認められる最大限の範囲で適用されるものとします。  

疑問点  

これらの条件に関するご質問は、当社にお問い合わせください。  

https://www.hexagongeospatial.com/about-us/our-company/contact-us

